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Chapter 1. Developers' Guide

This developers' guide is for:

* programmers who want to just use Apache Isis to build applications, and want help setting up
their development environment or to build their code from the command line (eg to execute
within a continuous integration server such as Jenkins)

* programmers who want to contribute back patches (bug fixes, new features) either to the
codebase or the framework’s documentation

» committers of Apache Isis itself who want guidance on release process, publishing documents
and other related procedures.

1.1. Other Guides

Apache Isis documentation is broken out into a number of user, reference and "supporting
procedures” guides.

The user guides available are:

* Fundamentals

* Wicket viewer

* Restful Objects viewer
* Security

» Testing

Beyond the Basics
The reference guides are:

* Annotations
¢ Domain Services

* Configuration Properties

Classes, Methods and Schema
* Apache Isis Maven plugin

 Framework Internal Services
The remaining guides are:

* Developers' Guide (this guide)

* Committers' Guide (release procedures and related practices)


ugfun.pdf
ugvw.pdf
ugvro.pdf
ugsec.pdf
ugtst.pdf
ugbtb.pdf
rgant.pdf
rgsvc.pdf
rgcfg.pdf
rgcms.pdf
rgmvn.pdf
rgfis.pdf
cgcom.pdf

Chapter 2. Using an IDE

The vast majority of Java developers use an IDE to assist with developing their code, and we highly
recommend that you do like wise as you develop your Apache Isis applications using an IDE.
Apache Isis is built with Maven, and all modern IDEs can import Maven projects.

This chapter shows how to setup and use two of the most popular IDEs, Intelli] IDEA and Eclipse.

2.1. Developing using Intelli] IDEA

This material does not constitute an endorsement; JetBrains is not affiliated to
Apache Software Foundation in any way. JetBrains does however provide
complimentary copies of the Intelli] IDE to Apache committers.

This section describes how to install and setup JetBrains' Intelli] IDEA, then how to import an
application into Intelli] and run it.

2.1.1. Installing and Setting up

This section covers installation and setup. These notes/screenshots were prepared using Intelli]
Community Edition 14.1.%, but are believed to be compatible with more recent versions/other
editions of the IDE.

Download and Install

Download latest version of Intelli] Community Edition, and install:

Start the wizard, click through the welcome page:

i} Intelli) IDEA Community Edition Setup - O

Welcome to the IntelliJ IDEA
Community Edition Setup Wizard

This wizard will guide you through the installation of Intelli
IDEA Community Edition.

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue.

Cancel

s

Figure 1. Intelli] Installation Wizard - Welcome page

Choose the location to install the IDE:


https://www.jetbrains.com/idea/download/

Choose Install Location

Choose the folder in which to install Intellil IDEA Community
Edition.

Setup will install IntelliJ IDEA Community Edition in the following folder. To install in a
different folder, click Browse and select another folder. Click Next to continue.

Destination Folder

)\JetBrains\Intelli] IDEA Community Edition 14.1.1

Space required: 553.6MB
Space available: 30.6GB

Figure 2. Intelli] Installation Wizard - Choose Location

Adjust any installation options as you prefer:

Installation Options
Configure your Intelli IDEA Community Edition installation

0

Create associations

[.java

Figure 3. Intelli] Installation Wizard - Installation Options

and the start menu:



Choose Start Menu Folder

Choose a Start Menu folder for the Intellid IDEA Community
Edition shortcuts.

Select the Start Menu folder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder.

7-Zip
Accessibility

Accessories

Administrative Tools

Agent Ransack (G64-bit)
Apache Tomcat 7.0 Tomcat?
Atlassian

Beyond Compare 3
ChocolateyGUI

Chrome Apps

Dolby
Dropbox

Figure 4. Intelli] Installation Wizard - Start Menu Folder

and finish up the wizard:

Completing the IntelliJ IDEA
Community Edition Setup Wizard

Intellid IDEA Community Edition has been installed on your
computer.

Click Finish to close this wizard.

[+[iRun Intglli] IDEA Community Edition;

< Back Cancel

Figure 5. Intelli] Installation Wizard - Completing the Wizard

Later on we’ll specify the Apache Isis/ASF code style settings, so for now select I do not want to
import settings:



)| Complete Installation n

You can import your settings from a previous version of Intellil IDEA.

() I want to import my settings from a custom locatior

Specify config folder or installation home of the previous version of IntelliJ IDEA:
C:\Program Files (x86)\JetBrains\Intelli] IDEA 14.0
i:o:il I do not have a previous version of IntelliJ IDEA or I do not want to import my settings

oK

Figure 6. Intelli] Installation Wizard - Import Settings

Finally, if you are a trendy hipster, set the UI theme to Darcula:

Bl Customize IDEA n
UI Themes — Default plugins — Featured plugins
Set UI theme
(®) IntelliJ ) Darcula
module ) [ src ) (€ Helloworld £a module
¥ c* Hellowerld.java x . GH
g E%]:meort javax.swing.*; .
] f—]:i_mport java.awt.*;
|
public class HelloWorld |
£ ©  public HelloWorld() {
g [ ] JFrame frame = new JFrame ("Hello wor
] JLabel label = new JLabel({):
g" lakel.setFont (new Font{"Serif", Font -
- "
1abeld | Breakpaints :
frame J
frame d + — a B
frame d

framel | B [ @ Line Breakpoints
frame | I Line 6 in HelloWorld.Hello
& } B[] @ Exception Breakpoints

(] any exception

[+ public sta

UI theme can be changed later in Settings | Appearance & Behavior | Appearance

Skip All and Set Defaults Next: Default plugins

Figure 7. Intelli] Installation Wizard Set UI Theme

New Project

In Intelli] a project can contain multiple modules; these need not be physically located together. (If
you are previously an Eclipse user, you can think of it as similar to an Eclipse workspace).

Start off by creating a new project:



P |

Intellid IDEA

Version 14.1.1

% Create New Project [/\\3

ICd Import Project
1 Open

¥ Check out from Version Control +

4 Configure ~ Get Help +

Figure 8. Intelli] Create New Project

We want to create a new Java project:

Project SDK: | <None>

‘%' Android
5 Java FX
% Intelli) Platform Plugin

Additional Libraries and Frameworks:
1 Intelli) Platform Plugin SDK
“# Android SDK

m Maven

& Gradle

© Groowy
@ Griffon

2 Empty Project

Use library: | [Mo library selected] - l Create...]

Error: library is not specified

(v | N [(concet | [ hep |

Figure 9. Intelli] Create New Project - Create a Java project

We therefore need to specify the JDK. Apache Isis supports both Java 7 and Java 8.



ASCIIEG B X O @+ Hide path
C\Program Files\Java\jdk1.7.0_45

» [ glassfish-4.0
[ Greenshot

B HP [%

os

1 11S Express

[ intel

3 Internet Explorer

[ Java

jdk1.7.0_45

[ jdk1.8.0_05

» [jdk1.8.0_11

» Bjre7

» Cjres

Drag and drop 2 file inte the space above to quickly locate it in the tree.

Figure 10. Intelli] Create New Java Project - Select the JDK

Specify the directory containing the JDK:

Project name: | dev

Project 1ocation:| C:\intellijprojects\dev{

N

* Mare Settings

v (D (o ] e

Figure 11. Intelli] Create New Project - Select the JDK location

Finally allow Intelli] to create the directory for the new project:



bl Directory Does Not Exist n

The project file directory
"C\intellijprojects\dev”
does not exist. It will be created by Intelli) IDEA.

Figure 12. Intelli] Create New Project

File templates

Next we recommend you import a set of standard file templates.

classes or supporting files:

|5/=8 Edit View Mavigate Code Analyze Refactor Build Run Tools VCS Window |

3 Open... Project from Existing Sources...
Open Recent » Project from Version Contral [
Close Project Module...
P Settings... Ctrl+Alt+S Module from Existing Sources...
[ Project Structure... Ctrl+Alt+Shift+5 (© Java Class
Other Settings * [L Kotlin File/Class
Import Settings... El File
Export Settings... E3 Bash Script
Settings Repository... 1 Package

K Save Al Ctri+S [f] package-infojava
Ctri+Alt+Y B HTML File
fl Apache Isis Domain Entity

@ Synchronize

Invalidate Caches / Restart...
Export to HTML... i Apache lsis Domain Mixin
= Print... fil Apache lsis Domain Service (Menu)

il Apache Isis Domain Service (Repository)

-

Add to Favorites
i Apache |sis Domain Service (Subscriber)

fil Apache lsis Fixture (Create)

i Apache lsis Fixture (Rowhandler)
il Apache lsis Fixture (Teardown)
i Apache lsis View Model (JAXE)
L aryet a Apache lsis View Model {regular)

File Encoding

-

Line Separators
Make File Read-only

Power Save Mode

Exit

B datanucleus.log i] Singleton

F_'; Apache lsis Domain Object Layout (XML)

[t logd) properties

Figure 13. File templates

These are used to create new

The file templates are provided as a settings JAR file, namely isis-settings-file-templates.jar.

Download this file.

Next, import using File > Import Settings, specifying the directory that you have downloaded the

file to:


resources/appendices/dev-env/intellij/isis-settings-file-templates.jar

L) Import File Location

Select the settings file to import or directory where the file is located

achHEOQ BX O & Hide path
| Ch\Users\Dan\Downloads\settings |ﬁ

il isis-settings-code-stylejar

: isis-settings-file-templates.jar

: isis-settings-live-templates.jar
— .
Drag and drop 2 file into the spac

uickly locate it in the tiee

I (o | [ e |

Figure 14. Intelli] Import Settings - Specify JAR file

Select all the categories (there should just be one), and hit OK. then hit restart.

Apparently no categories are shown if importing into Intelli] 2016.1.1 Community
Edition (and perhaps other 2016 versions). The file does import ok into Intelli]
15.0.%, so we think this is a bug in the 2016 version.

The workaround is to extract the .jar file locally and copy the files into IntelliJ’s
A config directory, somewhere in your home directory:

* Windows <User home>\.Ideal(2016\config
* Linux ~/..IdealC2016/config
* Mac OS ~/Library/Preferences/IdealC2016

Live templates

We also recommend you import a set of live templates. These are used to add new methods to
existing classes:

public class CustomerOrder implements Comparable<CustomerOrder> {

i
isc-jdo-1m-b-fk Apache Isis Collection (JDO, 1:m parent bidirectional to foreign key) -
isobj-events Apache Isis Object: abstract domain events declarations
isp-jdo Apache Isis Property (JDO)
isa Apache Isis Action
isa-dis Apache Isis Action disablement
isa-event Apache Isis Action (with domain event)
isa-event-decl Apache Isis Action (domain event declaration only)
isa-hid Apache Isis Action visibility
isa-p-auto Apache Isis Action parameter auto-complete
isa-p-cho Apache Isis Action parameter choices
isa-p-def Apache Isis Action parameter defaults
isa-p-val Apache Isis Action parameter validation
isa-val Apache Isis Action validation
isc-dis Apache Isis Collection disablement
isc-event-decl Apache Isis Collection (domain event declaration only)
isc-hid Apache Isis Collection wisibility
isc-jdo-1m-b-jt Apache Isis Collection (JDO, 1:m parent bidirectional to join table)
isc-jdo-1m-u-fk Apache Isis JDO Collection (1l:m parent unidirectional)
isc-jdo-1m-u-jt Apache Isis Collection (JDO, 1:m parent unidirectional to join table)
isc-jdo-mn-ub-c Apache Isis Collection (JDO, m:n child)
Ctrl+Down and Ctrl+Up will move caret down and up in the editor >> T

P

Figure 15. Live templates



The live templates have a prefix of prefixed either:

* is: for Apache Isis domain objects
* ju: for JUnit tests

* jm: for J]Mock mocks or libraries

ad : for Asciidoc documentation; a full list can be found in the appendix.

The live templates are also provided as a settings JAR file, namely isis-settings-live-templates.jar.
Download and import (as for the previous settings JAR files).

Coding Standards

Next, we suggest you recommend you import settings for standard ASF/Apache Isis coding
conventions. This file is also provided as a settings file, namely isis-settings-code-style.jar.
Download and import (as for the above settings JAR files).

Other Settings (Compiler)

There are also some other settings that influence the compiler. We highly recommend you set
these.

On the Compiler Settings page, ensure that build automatically is enabled (and optionally compile
independent modules in parallel):

| Settings n

(Q ) Build, Execution, Deployment > Compiler = For current project Reset
Appearance & Behavior Resource patterns: | 12 java;!?* form;17% class;17*.groovy;1 7% scala;17* flex;| 2% kil 7%.clj;17%.a | ®
se ; to separate patterns and ! to negate a pattern. Accepted wildcards: ? — exa one symbol; © — Zero or
Keymap Use ; to separate patt d !'to negate a pattern. Accepted wildcards: ? ctly ymbal; *
Editor more symbols; / — path separator; /**/ — any number of directories; <dir_name=>:<pattern> — restrict to

. source roots with the specified name
Plugins

v . .
Version Control B4 Clear output directory on rebuild

Build, Execution, Deployment Add @NotMNull assertions

Build Tools Automatically show first error in editor
Maven Display notification on build completion
Gradle Make project automatically (only works while not running / debugging)
Gant
— - . . .
E4 Compile independent modules in parallel (may require larger heap size)
Excludes Rebuild module on dependency change
Java Compiler Build process heap size (Mbytes): 700
Annotation Processors - - -
o Additional build process VM options: |
Validation
RMI Compiler

Groowvy Compiler
Gradle-Android Compiler
Android Compilers

i}

Coverage
Debugger
Path Variables

“ I Cancel ‘ I Apply ‘ I Help ‘

Figure 16. Intelli] Compiler Settings

On the Annotation Processors page, enable and adjust for the 'default’ setting:

10


resources/appendices/dev-env/intellij/isis-settings-live-templates.jar
resources/appendices/dev-env/intellij/isis-settings-code-style.jar

I settings »
@ ) Build, Execution, Deployment > Compiler > A on P T @ T
Editor + — # Enable annotation processing
mve Spas
v -
Fie Types BE e ee—
Copyright Cadev
Ei: Caisis O Processor path: ‘ ‘ B
3 isis-app-kitchensink
Images o Store generated sources relative to: O Module output directary © Module content root
Intentions Ca isis-app-kitchensink-app
Language Injections i isis-app-kitchensink-dom Production sources directory: ‘ target/generated-sources/annotations ‘
Speling [ isis-app-kitchensink-fixture
TODO [aisis-app-kitchensink-integtests Test sources directory: ‘ target/generated-test-sources/test-annotations ‘
Plugins Lasis-app-kitchensink-webapp Annotation Processors
= 3 isis-core-security
Versian Control B Processor FQ Name =+
Build, Execution, Deployment ® isis-documentation
Build Tools [ isis-viewer-wicket-applib ompiler run all automatically discovered process
Compiler Ca isis-viewer-wicket-impl
Excludes 3 isis-viewer-wicket-model
Java Compiler 3 isis-viewer-wicket-ui
S Amotation rocessor options
& simpleapp-app
Valigation Option Name Value =+
RMI Compiler [ simpleapp-dom
oy Fisimpleapp-ficture No processar-specific options canfigured
Coverage 3 simpleapp-integtests -
Debugger [Ca simpleapp-webapp
Path Variables Maven default annotation processors profile
Languages & Frameworks Annotation profile for asdidoctor-mawven-plugin WARNING!
el Annotation profile for estatio-dom If option 'Clear output directory on rebuild’ is bled, the entire of di ies where d
Other Settings sources are stored WILL BE CLEARED on rebuild.
o e ey

Figure 17. Intelli] Annotation Processor Settings

This setting enables the generation of the Q* classes for DataNucleus type-safe queries, as well as
being required for frameworks such as Project Lombok.

Intelli] may also have inferred these settings for specific projects/modules when
importing; review the list on the left to see if the default is overridden and
fix/delete as required.

Other Settings (Maven)

There are also some other settings for Maven that we recommend you adjust (though these are less
critical):

First, specify an up-to-date Maven installation, using File > Settings (or Intellil > Preferences if
on MacOS):

11



(C’\ maven Q)

7 Appearance & Behavior
Notifications
Keymap
7 Editor
Inspections
File and Code Templates
Live Templates

Plugins
7 Build, Execution, Deployment
¥ Build Tools

Ignored Files
Runner
Running Tests
Repositaries

Build, Execution, Deployment > Build Tools > Maven “ For current project
[ Work offline

[J Use plugin registry

Execute goals recursively

[ Print exception stack traces

[ Always update snapshots

QOutput level: Info A
Checksum policy: No Global Policy [
Multiproject build fail policy: A
Plugin update policy: & ignored by Maven 3+

Threads (-7 oprion):

Maven home directory: Bundled (Maven 3)

Bundled (Maven 2}

Bundled (Maven 3)
C:/binfapache-maven-3.2.3
CAUsers\Dan\.m2\repository

User settings file:

Local repository:

- L] Override

| o« IEENRETRETY

Figure 18. Intelli] Maven Settings - Installation

Still on the Maven settings page, configure as follows:

12




N Settings n

(Q ) Build, Execution, Deployment  Build Tools » Maven > Importing © For current project Reset
Appearance & Behavior
Keymap [[] Keep project files in: |
Editor
Plugins Import Maven projects automatically
Version Control Create Intelli) IDEA modules for aggregator projects (with '‘pom’ packaging)
Build, Execution, Deployment Create module groups for multi-module Maven projects
Build Tools
Maven Keep source and test folders on reimport

Importing Exclude build directory (%PROJECT_ROOT%/target)

Ignored Files Use Maven gutput directories
Runner

Generated sources folders: [Detect automatically [k -

Phase to be used for folders update: hd

Running Tests

Repositories

Gradle
Gant IDEA needs to execute one of the listed phases in order to discover all source folders that are configured via Maven plugins.
. Note that all test-* phases firstly generate and compile production sources.
Compiler
Coverage Automatically download: [] Sources [] Documentation
Debugger

Dependency types: | jar, test-jar, maven-plugin, ejb, ejb-client, jboss-har, jboss-sar, war, ear, bundle
Path Variables

Languages & Frameworks

Comma separated list of dependency types that should be imported

Tools WM options for impor‘ter:| -Xmx312m
Other Settings

DK for \'mporter:‘ E2 Use Internal JRE (java version "1.8.0_40", path: C:/Program Files (x86)/Je..unity Edition 14.1.1/jre/jre) n

Co iy

Figure 19. Intelli] Maven Settings - Configuration

Other Settings (Misc)

These settings are optional but also recommended.

On the auto import page, check the optimize imports on the fly and add unambiguous imports on
the fly

13




bl Settings H

(Q ) Editor : General > Auto Import Reset
Appearance & Behavior WML
Keyma
ymap Show import popup
Editor
General Java
Smart K
IR L Insert imports on paste: v
Appearance
Editor Tabs Show import popup
Code Folding Optimize imports on the fly
Code Completion Add unambiguous imports on the fly

- Exclude from Import and Completion
Postfix Completion

Console Folding +
Colors & Fonts ) =
Code Style 10 exclude patter

Java

Groovy

HTML

JSON

Properties

XML
Inspections [%

File and Code Templates
File Encodings

- S Py

o Jreiyen iy

Figure 20. Intelli] Maven Settings - Auto Import

2.1.2. Importing Maven Modules

Let’s load in some actual code! We do this by importing the Maven modules.

First up, open up the Maven tool window (View > Tool Windows > Maven Projects). You can then use
the 'plus’ button to add Maven modules. In the screenshot you can see we’ve loaded in Apache Isis
core; the modules are listed in the Maven Projects window and corresponding (Intelli]) modules are
shown in the Projects window:

14



Fle Edt View Navigate Code Anabze Refactor Build Run Tools VCs Window Help

ODHO ¢4 XD0 QAR ¢ HEJremy @ ¥a ? Q
& Add Maven Projects | a1
w [ core [isis] (CAAPACHE\is-0 P IR g
» 3 applib [isis-core-applib] [ Profiles H
» [ fakedata T Apache Isis Care (root)
s i
FIg =] it [t [ Isis Core (Bypass) Security
S|+ alogsj lisis-core-logdj] 7 sis Core AppLib
| » Camaven-plugin isis-maven-plugin] 7 Isis Core Integration Testing Support
» [ metamodel [isis-core-metamodel] 7 Isis Core Log4j Impls
» [ abjectstore-inmemory [ Isis Core MetaModel
» L runtime [lslsw-rf—mml me] . ) Isis Core RestfulObjects Viewer Applib
» E3 security-noop [isis-core-security] ) Isis Core RestfulObjects Viewer Rendering
» [ security-shiro [sis-core-security-shiro] 7 Isis Core RestfulObjects Viewer Server
» [ specsupport [isis-core-specsupport] [ Isis Core Runtime
» EIsrc [ Isis Core Shiro Security
» Eltarget [ Isis Core Spec Support
» [ unittestsupport [isis-core-unittestsupport] [ Isis Core Unit Test Support
[ =] pplib [isi: i jt PP ) Isis Core WebServer
[ -] g i [ Isis Core Wrapper Service
> [ 7 Isis Maven Plugin (isis-maven-plugin)
» [ viewer-wicket [isis-viewer-wicket] T Isis Wicket Viewer
» L2 webserver [isis-core-webserver] ) Isis Wicket Viewer Applib
» L& wrapper [isis-core-wrapper] 7 Isis Wicket Viewer Implementation
I isisiml 7 Isis Wicket Viewer Modlel
[El nomice ) Isis Wicket Viewer U Components
m pom.xml
[E) pom.mlversionsbackup
il External Libraries
§1000 [ Terminal [ Eventlog
Add and import Maven projects to the projects tree (e & [EEaEtasm]

Figure 21. Intelli] Maven Module Management - Importing Maven modules

We can then import another module (from some other directory). For example, here we are
importing the Isis Addons' todoapp example:

AEIGEX O & Hide path
‘ CAGITHUB\isisaddons\isis-app-todoapp\pom.xml ||§
= [ bhargavgolla
[ chrissg
[ cucumber
[ danhaywood
[ datanucleus
[ detro
[ dileepajayakody
[ DimuthuUpe
[ estatio
[ geb
[ isisaddons [%
» [ isis-app-kitchensink
» [ isis-app-necapp
v [isis-app-todoapp

» dom
[ fisture
[ images
[ integtests
[ logs
[ webapp

[ isis-jrebel-plugin

4 ¥ ¥ ¥ Y Y YVYVYY

[ isis-metamodel-paranamesd

[ isis-module-audit
[ isis-module-command

[ isis-module-devutils
Drag 2nd drop 2 fie into the space above to quickly Jocste tin the tree

o NEENRIETN

Figure 22. Intelli] Maven Module Management - Importing another Module

You should then see the new Maven module loaded in the Projects window and also the Maven

15



Projects window:

|

File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

ODHO ¢4 X000 QR e« W@y B aPs 3 ?

A

v Caisis and modules
» Exisi
» 3 applib [isis-core-applib]

» [acore [isis]

> G t lisi

» [ loggj [isis-core-log4j]

» [a maven-plugin lisis-maven-plugin]
» £ metamocel [isis-core-metamodel]
» 3 runtime [isis-core-runtime]

#
L
pingi 3 | O

Gk + PR*ES® S F
» [ Profiles

» [ Apache Isis Core (root)

» [ Isis Addons ToDoApp (root)

» [ Isis Addons ToDoApp DOM

» [ Isis Addons ToDoApp Fixtures

[ Isis Addons ToDoApp Integration Tests
» [ Isis Addons ToDoApp Webapp

» [ Isis Core (Bypass) Security

» [ Isis Core AppLib

» [ Isis Core Integration Testing Support
» [ Isis Core Log4j Impls

» [ Isis Core MetaModel

» [ Isis Core RestfulObjects Viewer Applib
» [ Isis Core RestfulObjects Viewer Rendering
» [ Isis Core RestfulObjects Viewer Server
» [ Isis Care Runtime

» [ Isis Core Shiro Security

» [ Isis Core Spec Support

» [ Isis Core Unit Test Support

» [ Isis Core WebServer

» [ Isis Core Wrapper Service

wer-wicket and modules

v

» L3 security-noop [isis-core-security]

» [ security-shiro [isis-core-security-shiro]

» [ specsupport [isis-core-specsupport]

» E3 unittestsupport [isis-core-unittestsupport]
e .

> Caviewer- pplib [i jects-appl

» [Caviewer dlering [isi

» [Caviewer-r
» L2 webserver [isis-core-webserver]

PP
» [ fiture [todoapp-fixture]
» [aintegtests [todoapp-integtests]
» [aisis-app-todoapp [todoapp]
» 3 webapp [tedoapp-webapp]
» Hils External Libraries

» [ Isis Maven Plugin (isis-maven-plugin)
b [ Isis Wicket Viewer

» [ Isis Wicket Viewer Applib

» [ Isis Wicket Viewer Implementation

» [ Isis Wicket Viewer Model

» [ Isis Wicket Viewer Ul Components

Fl
*

W 57000 [E Terminal | version Control 1 EventLog
Frameworks detected: Wicket framework is detected in the project Configure (11 minutes aga) 51 Indexing... @ 5 Gmaster ¢ & 0 [isorasem]

Figure 23. Intelli] Maven Module Management -

If any dependencies are already loaded in the project, then Intelli] will automatically update the
CLASSPATH to resolve to locally held modules (rather from .m2/repository folder). So, for example
(assuming that the <version> is correct, of course), the Isis todoapp will have local dependencies on
the Apache Isis core.

You can press F4 (or use File > Project Structure) to see the resolved classpath for any of the
modules loaded into the project.

If you want to focus on one set of code (eg the Isis todoapp but not Apache Isis core) then you could
remove the module; but better is to ignore those modules. This will remove from the the Projects
window but keep them available in the Maven Projects window for when you next want to work on
them:
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Fle Edt View Navigate Code Anabze Refactor Build Run Tools VCs Window Help

OHO #A %00 QAR ¢ W]re@m QPSS ¥@E ? Q
B O | %I * %
s and moduies Ok + PRTHE S B i
» [z isis-viewer-wicket and modules » [oprofiles g
> :.iannhb [isis-core-applib] + [ Apache Isis Core (oo l\@ Reimport
S core [isis]
g l_: - » [ Isis Addons TaDoARp (ract] |z Generate Sources and Update Folders
e r] <t iste » [ Isis Addons ToDoApp DOM
| > Calogy lisis-core-log4j] » [ Isis Addons ToDoApp Fixtures
» [ maven-plugin [isis-maven-plugin] + ) s Addons ToDopp Inegrarig — ReTOVe Profects
» [ metamode! [isis-core-metamodel] » T isis Addons ToDoApp Webapp  OPen 'settings.xmi
» L& runtime [isis-core-runtime] + ) Isis Core (Bypass) Security Open profiles.xml
» [ security-noop lisis-core-security] + [ Isis Core Applib £ Download Sources
> [ security-shiro _['f's'w’!'ﬂ""'y'!""'ﬂ] [ Isis Core Integration Testing Suj & Download Documentation
4 Esuecsummﬂ [m[smre—swsuvwﬂl ! » [ Isis Care Log4j Impls 2 Download Sources and Documentation
» 3 unittestsupport [isis-core-unittestsupport]
i i runi ° + [ Isis Core MetaModel Show Effective POM
] pplib [i PPl » [ Isis Core Restfulobjects Viewer > o o
Y i e un Maven Bui
> G viewer ing [i [ Isis Core RestfulObjects Viewer
. e B
> L3viewer [ ) Isis Core RestfulObjects Viewer [ Jump to Source G2
» [ webserver [isis-core-webserver] » [ Isis Core Runtime
» [3wrapper [isis-core-wrapper] [ Isis Core Shiro Security
+ [itodoapp and modules + [ Isis Core Spec Support
[ =] :fnm [IodDﬂPP'dﬂ.M] [ Isis Core Unit Test Support
» [ fisture [todoapp-fixture] » [ Isis Core WebServer
» [Caintegtests [todoapp-integtests] » T Isis Core Wrapper Service
» [aisis-app-todoapp [todoapp] + T Isis Maven Plugin (isis-maven-plugin)
» [ webapp [todoapp-webapp] [ Isis wicket Viewer
» il External Libraries » [ Isis Wicket Viewer Applib
+ [ Isis Wicket Viewer Implementation
» [ Isis Wicket Viewer Model
» [ Isis Wicket Viewer Ul Components
]
*
261000 [E Terminal [ Version Control ™ Event Log

/e |Gt master +| % 8 | erasm]

Exclude/Include selected Maven projects from being imported

Figure 24. Intelli] Maven Module Management - Ignoring Modules

Confirm that it’s ok to ignore these modules:

These modules have been removed from Maven structure:
Isis’

core-specsupport’

core-viewer-restfulobjects-applib’

core-metamodel

core-viewer-restfulobjects-rendering’

maven-plugin’

core-webserver'
'Isis-viewer-wicket-impl'

‘Isis-viewer-wicket-applib'

isis-core-integtestsupport’
‘isis-viewer-wicket-ui’
isis-core-security-shiro’
s-viewer-wicket-model
core-wrapper'
core-viewer-restfulobjects-server'
‘isis-core-runtime’
isis-core-unittestsupport’

Figure 25. Intelli] Maven Module Management - Ignoring Modules (ctd)

All being well you should see that the Projects window now only contains the code you are working
on. Its classpath dependencies will be adjusted (eg to resolve to Apache Isis core from
.m2/repository):
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x

aEs ¥a@ ?

ODHG ¢4 %00 QAR ¢ B> c@Y

| Beoea ] = -
+ [atodoapp and modules

OB& + PRT® = B

> [ dom [todoapp-dom [ Profiles
: E_i'i’:‘"; m‘i"}"ﬁ] . T Apache Isis Core (root)
= integtests pp-integtests|
» Laisis-app-todoapp [todoapp] [ Isis Addons ToDoApp DOM
» [ webapp [todoapp-webapp] [ Isis Addons ToDoApp Fictures,
> HirExternal Libraries ) Isis Addons ToDoApp Integration Tests
) Isis Addons ToDoApp Webapp
[ Isis Core (Bypass) Security
R Isis Core Applib
[ Isis Core Integration Testing Support
[ Isis Core Logdj Impls.
[ Isis Core MetaModel
f Isis Core RestfulObjects Viewer AppLib
[ Isis Core RestfulObjects Viewer Rendering
[ Isis Core RestfulObjects Viewer Server
T Isis Core Runtime
[ Isis Core Shiro Security
f Isis Core Spec Support
R Isis Core Unit Test Support
T Isis Core WebServer
G Isis Core Wrapper Service

v

T Isis Maven Plugin (isis-maven-plugin)
T Isis Wicket Viewer

R Isis Wicket Viewer Applib

R Isis Wicket Viewer Implementation
[ Isis Wicket Viewer Model

[ Isis Wicket Viewer Ul Components.

% 8:Favorites

ping s | O

261000 [E Terminal [ Version Control

™ Eventlog

Frameworks detected: Wicket framework is detected in the project Configure (12 minutes ago)

Figure 26. Intelli] Maven Module Management - Updated Projects Window

2.1.3. Running

Let’s see how to run both the app and the tests.

Running the App

/e |G master + | & | EERs]

Once you’ve imported your Isis application, we should run it. We do this by creating a Run

configuration, using Run > Edit Configurations.

Set up the details as follows:
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b Run/Debug Configurations n

+ -H ¥+ +0l2 Name: |todoapp |
® Application

[ Share Single instance only

Configuration ‘ Code CDverage‘ Logs ‘ StartuprDnnectiDn|

=todoapp -
] JUnit Main class: |org.apache.isis.WebServer | D
% Defaults VM options: | ‘
Program arguments: | ‘
Working directory: | $MODULE_DIRS ||_HE
Environment variables: | ‘D

% todoapp-webapp -

[ Use alternative JRE: | HD

[C1 Enable capturing form snapshots

Use classpath of mod...

~ Before launch: Make, Maven Goal

+ -7t 3

4ii Make

m Run Maven Goal ‘Isis Addons ToDoApp DOM: datanucleus:enhance -0

“ | cancel | | appiy | | Help |

Figure 27. Intelli] Running the App - Run Configuration

We specify the Main class to be org.apache.isis.WebServer; this is a wrapper around Jetty. It’s
possible to pass program arguments to this (eg to automatically install fixtures), but for now leave
this blank.

Also note that Use classpath of module is the webapp module for your app, and that the working
directory is $MODULE_DIRS.

Next, and most importantly, configure the DataNucleus enhancer to run for your dom goal. This can
be done by defining a Maven goal to run before the app:

Bl Select Maven Goal n
Working directory ‘ C:/GITHUB/isisaddons/isis-app-todoapp/dom ‘DE
Command line |datanucleus:enhance -0 |

o

Figure 28. Intelli] Running the App - Datanucleus Enhancer Goal

The -o flag in the goal means run off-line; this will run faster.
if you forget to set up the enhancer goal, or don’t run it on the correct (dom)
A module, then you will get all sorts of errors when you startup. These usually

manifest themselves as class cast exception in DataNucleus.

You should now be able to run the app using Run > Run Configuration. The same configuration can
also be used to debug the app if you so need.
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Running the Unit Tests

The easiest way to run the unit tests is just to right click on the dom module in the Project Window,
and choose run unit tests. Hopefully your tests will pass (!).

3 isis-app-todoapp [todoapg

Find Usages Alt+F7
~idom [todoapp-dom] 4 path Ctrl+Shift+F
B fixture [todoapp-fixturs Replace in Path... Ctrl+Shift+R
CJimages

Analyze »
[3 integtests [todoapp-int

Refactor ’
Bllogs
[awebapp [todoapp-web;  Add to Favorites g
[ gitattributes Show Image Thumbnails Ctrl+Shift+T
4 gitignore Reformat Code... Ctrl+Alt+L
E travisyml Optimize Imports... Ctrl+Alt+O
B bumpver.sh Remove Module Delete
B datanucleus.log £ Run Maven N
5 LICENSE # Debug Maven 4
m pom.xml

. Make Module ‘todoapp-dom’
B pom.xmlversionsBackup

M README.md
I todoapp.iml

Compile Module ‘todoapp-dom’ Ctrl+5Shift+F9
@] Create "All Tests"...
[ A Run "All Tests k

Ciisis-module-sessionlogge

Figure 29. Intelli] Running the App - Unit Tests Run Configuration

As a side-effect, this will create a run configuration, very similar to the one we manually created for
the main app:
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b Run/Debug Configurations n

+ — O H%+ ¥+ 012 MName: |AII in todoapp-dom | [l Share [J Single instance only
= Application .
= JUnit Configuration ‘ Code CDverage‘ Logs ‘ StartuprDnnectiDn|
All in todoapp-dom Test kind: All in package [ Fork mode:
All in todoapp-integtests package: | | D
% Defaults

Search for tests: O In whole project
© In single module

O Across module dependencies

VM options: | -ea ‘
Program arguments: | ‘
Working directory: | SMODULE_DIRS | -]E]
Environment variables: | ‘D
Use classpath of mod... |Ca todoapp-dom n

[ Use alternative JRE: | HD

~ Before launch: Make
+ -2 1t ¥
41 Make

o« IR

Figure 30. Intelli] Running the App - Unit Tests Run Configuration

Thereafter, you should run units by selecting this configuration (if you use the right click approach
youw’ll end up with lots of run configurations, all similar).

Running the Integration Tests

Integration tests can be run in the same way as unit tests, however the dom module must also have
been enhanced.

One approach is to initially run the tests use the right click on the integtests module; the tests will
fail because the code won’t have been enhanced, but we can then go and update the run
configuration to run the datanucleus enhancer goal (same as when running the application):
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b Run/Debug Configurations n
+ -0 H %+ +DO 2

» [ Application .
v [ JUnit Configuration ‘ Code CDverage‘ Logs ‘ StartuprDnnectiDn|

All in todoapp-dom Test kind: All'in package |34 Fork mode:
All in todoapp-integtests

Package: | | D
» % Defaults
Search for tests: O In whole project

Name: |AII in todoapp-integtests | [l Share [J Single instance only

© In single module

O Across module dependencies

VM options: |-ea [®]
Program arguments: | [®]
Working directory: | $MODULE_DIR$ | -]E]
Environment variables: | -]

Use classpath of mod... |Ca todoapp-integtests n

[ Use alternative JRE: | HD

~ Before launch: Make, Maven Goal

+ -7t 3

Hi Make

m Run Maven Goal ‘Isis Addons ToDoApp DOM: datanucleus:enhance -o°

I (o] [ oo | [rep |

Figure 31. Intelli] Running the App - Integration Tests Run Configuration

Also make sure that the search for tests radio button is set to In single module:

?I Run/Debug Configurations X
+ —DH%¥*T DO Name: |AII in incode-estatio-ecp-migration-integte ‘ I share [ Single instance only
* D Application Configuration ‘ Code Coverage‘ Logs‘ Startupronnection|
v [@]JUnit -

Allin estatio-integtests Test kind: Fork mode:
PropertyMenuTestSNewProperty.newProperty R | | D
LeaseTestSNewMandate.whenSecondaryPartylsknownAndHasBanl

InvoiceCalculationServiceTest_normalRun Search for testss () In whole project

Allin incode-estatio-ecp-migration-integtests

o In single module
» % Defaults

(O Across module dependencies

VM options: ‘ -ea |
Program arguments: ‘ |

Working directory: ‘ SMODULE_DIRS | |
Environment variables: ‘ |D
Use classpath of mod... | [3 incode-estatio-ecp-migration-integtests -

[ Use alternative JRE: ‘ nl:’

~ Before launch: Make, Maven Goal
+ -2 1 +
He Make
I Run Maven Goal 'Estatio (ECP) DOM - Italy: datanucleus:enhance -o'

[ Show this page

o JEElyeipy

If this radio button is set to one of the other options then you may obtain class loading issues; these
result from Intelli] attempting to run unit tests of the dom project that depend on test classes in that
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module, but using the classpath of the integtests module whereby the dom test-classes (test-jar
artifact) are not exposed on the Maven classpath.

2.1.4. Hints and Tips

Keyboard Cheat Sheets

You can download 1-page PDFs cheat sheets for Intelli]’s keyboard shortcuts: * for Windows * for
MacOS

Probably the most important shortcut on them is for Find Action: - ctrl-shift-A on Windows - cmd-
shift-A on MacOS.

This will let you search for any action just by typing its name.

Switch between Tools & Editors

The Tool Windows are the views around the editor (to left, bottom and right). It’s possible to move
these around to your preferred locations.
* Use alt-1through alt-9 (or cmd-1 through alt-9) to select the tool windows
* Press it twice and the tool window will hide itself; so can use to toggle
 If in the Project Window (say) and hit enter on a file, then it will be shown in the editor, but
(conveniently) the focus remains in the tool window. To switch to the editor, just press Esc.

o If in the Terminal Window, you’ll need to press Shift-Esc.

* If on the editor and want to locate the file in (say) the Project Window, use alt-F1.

* To change the size of any tool window, use ctrl-shift-arrow

Using these shortcuts you can easily toggle between the tool windows and the editor, without using
the mouse. Peachy!

Navigating Around

For all of the following, you don’t need to type every letter, typing "ab" will actually search for
".a.*h.".
* to open classes or files or methods that you know the name of:
* ctrl-Nto open class
* ctrl-shift-Nto open a file
* (bit fiddly this) ctrl-shift-alt-N to search for any symbol.

» open up dialog of recent files: ctrl-E

 search for any file: shift-shift

Navigating around: * find callers of a method (the call hierarchy): ctrl-alt-H * find subclasses or
overrides: ctrl-alt-B * find superclasses/interface/declaration: ctr1-8
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Viewing the structure (ie outline) of a class * ctr1-F12 will pop-up a dialog showing all members **
hit ctr1-F12 again to also see inherited members

Editing
* Extend selection using ctrl-W

* and contract it down again using ctrl-shift-W

to duplicate a line, it’s ctr1-D

« if you have some text selected (or even some lines), it'll actually duplicate the entire
selection

to delete a line, it’s ctr1-X
* tomove a line up or down: shift-alt-up and shift-alt-down

« if you have selected several lines, it’ll move them all togethe

ctrl-shift-J can be handy for joining lines together

* just hit enter to split them apart (even in string quotes; Intelli] will "do the right thing")

Intentions and Code Completion

Massively useful is the "Intentions" popup; IntelliJ tries to guess what you might want to do. You
can activate this using " alt-enter ', whenever you see a lightbulb/tooltip in the margin of the current
line.

Code completion usually happens whenever you type ".". You can also use ctrl-space to bring these
up.

In certain circumstances (eg in methods0) you can also type ctrl-shift-space to get a smart list of
methods etc that you might want to call. Can be useful.

Last, when invoking a method, use ctrl-P to see the parameter types.

Refactoring

Loads of good stuff on the Refactor menu; most used are:
* Rename (shift-F6)
» Extract

* method: ctrl-alt-M

e variable: ctrl-alt-V

Inline method/variable: ctr1-alt-N

* Change signature

If you can’t remember all those shortcuts, just use ctrl-shift-alt-T (might want to rebind that to
something else!) and get a context-sensitive list of refactorings available for the currently selected
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Plugins

You might want to set up some additional plugins. You can do this using File > Settings > Plugins
(or equivalently File > Other Settings > Configure Plugins).

Recommended are:
* Maven Helper plugin
More on this below.
» AsciiDoctor plugin

Useful if you are doing any authoring of documents.

Some others you might like to explore are:

1l Platform and Plugin Updates -

Plugins from configured hosts are ready to update.
Uncheck plugins vou do not want to update,

¥ BashSupport (1.4.0_build141)

Bash 4 support for Intellid. Supports syntax
Wicket Source (1.2) highlighting, rename refactoring, documentation
lookup, inspections, quickfixes and much more.

.ignore (1.0.2)
GMU GetText files support (*.po) (134.5MAPSE | Twill marry in April and invite all happy users of

- - BashSupportto chip in by sending us a wedding
" 38,82 ’
B nididea (138.526) aift
JProfiler (14.1) _ _ .

o & Paypal: Send your gift to maii@&nsorg-it.

Markdown (0.2.7) & GoFundMe: Make a donation on
WicketForge (5.0.7) g!.:[nw.qolfgndme.comfbashsunﬂort

. . i & Bitcoin 1D:
String Manipulation (3.1.135.445) 157X0T1sRASEKZeK44JudzEm2X4LbQF

& Details: www.ansorg-it.com.

Change Notes
Changes in version 1.4.0:

& Fixed the "Run before” steps of a Bash
run configuration

@ The template Bash run configuration
has no default "make” run before step
naw

& Added basic Bash live templates: if, ife,
ifee, while, until, case, cap, cap2, cap3

To configure automatic update settings, see the Updates dialog of your IDE Settings.

Figure 32. Intelli] Plugins

Maven Helper Plugin

This plugin provides a couple of great features. One is better visualization of dependency trees
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(similar to Eclipse).

If you open a pom.xml file, you’ll see an additional "Dependencies"” tab:

m  simpleapp-webapp ‘
1@ [
11
12
13
14
15
16
17
18
bE]
20 <project xmlns="http://maven.apache.org/POH/4.0.90" xmlns:xsi="http://www.w2.0rg/2601/XHLSchema—instance” xsiischemalocation="http://maven.apache
+0rg/POM/4.8.8 http://maven.apache.org/maven-v4_8_8,xsd">
21 <modelVersion>4.8.0</modelVersion>
22 —
23 Ml <parent> -
24 <groupId>org.apache.isis.exanple.application</groupId>
25 <artifactId>simpleapp</artifactIid>
26 <versionz1.%.0-SNAPSHOT</version>
27 </parent>
28
25 <artifactId>simpleapp-webapp</artifactId>
26 <name>Simple App Webapp</name>
31
32 <description>This module runs both the Wicket viewer and the Restfulobjects viewer in a single webapp configured to run using the datanucleus
object store.</description>
33
34 <packaging>war</packaging>
35
36 <properties>
37 <siteBaseDir>..</siteBaseDir>
38 </properties>
39
40 <build>
41 <plugins>
42 <plugin>
43 <groupld>org.morthay.jetty</groupld>
42 & <artifactId>maven-jetty-plugin</artifactId>
45 </plugin>
46
a7 <l-- mvn package -->
48 <plugin>
49 <groupIdrorg.simplericity.jettyconsole</groupld>
58 <artifactId>jetty-console-maven-plugin</artifactId>
51 <executions>
52 <execution>
53 <goals>
54 <goal>createconsole</goal>
55 </goals> -
56 <configuration> —
57 <backgroundImage>${basedir}/src/mainfjettyconsole/isis-banner.png< /backgroundImage>
s8 <destinationFile>${project.build.directory}/s{project.build. finallane}-jetty-console.jar</destinationFile> -
55 </configuration>
) <phase>package</phase>
M- = I

Clicking on this gives a graphical tree representation of the dependencies, similar to that obtained
by mvn dependency:tree, but filterable.
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m  simpleapp-webapp

O Conflicts
O All Dependencies as List

All Deper

Refresh

geronimo-servlet_3.0_spec : 1.0 (compile)
hsqldb : 2.3.1 (compile)
isis-core-runtime : 1.9.0-SNAPSHOT (compile)
activation : 1.1.1 (compile)
axon-core : 2.4 (compile)
cglib-nodep : 2.2.2 (compile)
commoens-collections : 3.2.1 (compile)
commons-io : 2.4 (compile)
disruptor : 3.2.0 (compile)
joda-time : 2.3 (compile)
slfdj-api: 1.7.10 (compile)
xstream : 1.4.7 (compile)
xmlpull : 1.1.3.1 (compile)
Xpp3_min : 1.1.4c (compile)
commons-email : 1.3.3 (compile)
activation : 1.1.1 (compile)
domdj : 1.6.1 (compile)
xml-apis: 1.0.b2 (compile)
guava : 16.0.1 (compile)
hamecrest-library : 1.3 (compile)
.9.0-SNAPSHOT (compile)
guava: 16.0.1 (compile)
hamcrest-library : 1.3 (compile)

isis-core-log4j :

log4j : 1.2.17 (compile)

slfdj-api: 1.7.10 (compile)

slfdj-log4j12 : 1.7.10 (compile)
isis-core-metamodel : 1.9.0-SNAPSHOT (compile)

commons-cli : 1.2 (compile)

commons-codec: 1.9 (compile)

datanucleus-api-jdo : 4.0.5 (compile)

datanucleus-core : 4.0.6 (compile)

el SANA 1

POV ISR w——

The plugin also provides the ability to easily run a Maven goal on a project:
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File Edit View MNavigate Code Analyze Refactor Build Run

i simpleapp ' C3 webapp | AsciiDoc
I [ Project i % Cut
E [z incode-camel-coda and modules ] Copy
E'|_|I it isis-tck and modules Copy Path
[% necapp and modules Copy as Plain Text
E 2 org.apache.isis.core and modules Copy Reference
% [z simpleapp and modules [l Paste
v (3 dom [simpleapp-dom] Find Usages
3 fixture [simpleapp-fixture] Find in Path...
[Jintegtests [simpleapp-integtests] Replace in Path...
[i simpleapp Analyze
2 webapp [simpleapp-webapp]
B ide Refactor
Mlib Add to Favorites
[l logs Show Image Thumbnails
[ sre Reformat Code...
m pom.xml Optimize Impaorts...
[ todoapp and modules Remove Module
L2 content-OLDSITE ( e
Cadev (Chintellip £ Debug Maven
[3 documentation [isis-documentation] (¢ git
[ java-assertjext [danhaywood-java-assertjext] Make Medule simpleapp-webapp'
[ simpleapp [simpleapp-archetype] (¢ \isis-git-ry Compile ..e ‘simpleapp-webapp"
ik External Libraries DD T
» Run "All Tests'
[ (3 Debug "All Tests'
[€] Profile "All Tests'
¥ Run "All Tests' with Coverage
Local History
Git
@ Synchronize 'webapp'
Show in Explorer
File Path
& Compare With...
External Tools
Open Module Settings
- Move Module to Group
% Mark Directory As

New

Add Framework Support..

*ojects\dev] - simpleapp

Ctrl+X
Ctrl+C

Ctrl+Shift+C #che.org/licenses/LICENSE

Ctrl+Alt+Shift+C
Ctri+V

Alt+F7

Ctrl+Shift+F

Ctrl+Shift+r /maven.apache.org/PON/4.6
{maven.apache.org/maven-v
’9(!node1\'ers‘ion>

r
p2ache.isis.example.applic

npleapp</artifactId>
Ctrl+Shift+T _gyaAPSHOT</version>

Ctrl+Alt+L

Ctrl+Alt+0 spp-webapp</artifactId>

Delete zbapp</name>

T e e =

» & clean generate-sources
% help:effective-pom
Ctrl+Shift+F9 ¥ dependency:tree
% clean install

Ctrl+Shift+F10 % clean

% validate
& compile
& test ro
) % padcage ng
y & verify
£ install
Alt+X szploy ty
-t en
Ctri+Alt+F12 - ¢
&
crep B
Plugins be
4 @ Reimport
MNew Goal... s{

<destinationFile>S{
</configuration>

<nhacaz>narkaces /nhaca>

»

This menu can also be bound to a keystroke so that it is available as a pop-up:

28


images/appendices/dev-env/intellij-idea/050-some-plugins/maven-helper/030-maven-run-goal.png

dev - [CAintellijprojects\dev] - simpleapp-webapy

File Edit View Mavigate Code Analyze Refactor Build Run Teools VCS Window Help

[2simpleapp ' Ciwebapp

B [ Project - € = | 8- 1© | M simpleapp-webapp |

e [%incode-camel-coda and modules 18

i http://www.apache.org/licenses /LICENSE-2.0

b [zisis-tck and modules 1 EEp L apac 8/tie SLICENSE-2
12

L=z neoapp and modules 13

% Lt org.apache.isis.core and modules 14

=] 15

& E# simpleapp and modules 16

v [2 dom [simpleapp-dom] 17
18 under the License.

2 fixture [simpleapp-fixture]

._ p PP . 12 - Quick Run Maven Goal
E.‘lntegtests [simpleapp-integtests] 20 <project xmlns="http://maven. xmlns
E.‘simpleapp .org/POMf4.8.8 http://maven. _8.xsd

21 <modelVersion>4.0.0</mode
"2 webapp [simpleapp-webapp] 29 % clean generate-sources
Clide 23 <parent> 4 helpeffective-pom
24 <groupId>org.apache. . <fgr
Clie 25 <artifactId>simpleapg # dependencyitree
Clogs 26 <version>1.9.0-SNAPSH % dean instal
B src 27 </parent> % dean
28
M pom.xml 29 <artifactId>simpleapp-wel @ validate
L todoapp and modules 30 <name>53imple App Webapp</ # compile
Ca C OLDS 3 £ test
& content-OLDSITE (C ent-OLDSIT 32 <description>This module es iewer
o dev (Chntellijproj object store.</description> | & package
% documentation [isis-documentation] (C\APACHE = . .| T verify
34 <packaging>war</packaging
3 java-assertjext [danhaywood-java-assertjext] \a| 35 4 install
[ simpleapp [simpleapp-archetype] (C\APACHE sis-git-ruexa tyf 36 <properties> 4 deploy
o 37 <siteBaseDir>..</site .
il External Libraries = </properties> £ site
39 .
40 <build> # Jettyrun
41 <plugins= Plugins
42 <plugin>
43 <groupId>org. (J Reimport
44 § <artifactId>m New Goal ifact
45 </plugin>
45
47 <l-- mvn package ——>
Troubleshooting

When a Maven module is imported, IntelliJ generates its own project files (suffix .ipr), and the
application is actually built from that.

Occasionally these don’t keep in sync (even if auto-import of Maven modules has been enabled).

To fix the issue, try: * reimport module * rebuild selected modules/entire project * remove and then
re-add the project * restart, invalidating caches * hit StackOverflow (!)

One thing worth knowing; Intelli] actively scans the filesystem all the time. It’s therefore (almost
always) fine to build the app from the Maven command line; Intelli] will detect the changes and
keep in sync. If you want to force that, use File > Synchronize, ctrl-alt-Y.

If you hit an error of "duplicate classes":
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70 dev - [Ci\ldeaprojects\dev - Intelly IDEA 14.1.5 - v x
fle Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help

[ isis-app-kitchensink ) [ dom |

#*-

m\busrules\QBusRulesObject java
Error(6, 8) java: duplicate dlass:
org sisaddons.app kitchensink dom.busrules.
QBusRulesObject

-app-kitchensink-integtests]
» Caisis-app-kitchensink
> Cawebapp [isis-app-kitchensink-webapp]

» Cadev (C\ldeaProjects\dev)

> Eaisis-cli (CA\github\danhaywood\isis-cli

> i External Libraries

TSBiooiam | puiF O spaloidwenen T S ApeRiH 7w proRwy s | O

's.app kitchensink.dom.inject.Qln

m\text\QTextObject java
Error(6, 8) java: duplicate dass:
orgisisaddons.app kitchensink.dom.text.QTex
tObject

Errori(6, ) java: duplicate dass:
‘orgsisaddons.app itchensink.dom.timestam

pableinject QTimestampableObject

8 Favorrtes

then make sure you have correctly configured the annotation processor settings. Pay attention in
particular to the "Production sources directory" and "Test sources directory”, that these are set up
correctly.

2.1.5. Faster turnaround times

In this section are several options that will reduce the time it takes between making a source code
edit and seeing the results in the running app. code/build/deploy/review feedback loop.

Using Grade to compile/enhance

Running an Apache Isis application requires that the DataNucleus enhancer runs on the compiled
bytecode. As described above, the recommended way to do this with Intelli] is to use a Run
configuration that runs the enhancer goal prior to launch.

Alternative, you can use the following build.gradle script in your dom module:
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build.gradle

apply plugin: 'java'
apply plugin: 'tangram.tools'
sourceCompatibility = 1.8
targetCompatibility = 1.8
version = (new XmlParser()).parse('pom.xml"').parent.version.text()
buildscript {
repositories {
maven { url "http://oss.jfrog.org/artifactory/oss-snapshot-local” }
jcenter()
}
dependencies {
classpath 'tangram:gradle-plugin:1.1.2'
}
}
repositories {
mavenLocal()
maven { url "http://oss.jfrog.org/artifactory/oss-snapshot-local” }
jcenter()
}
dependencies {
compile group: 'org.apache.isis.core', name: 'isis-core-applib', version: version

}
task copyClasses << {
copy {
from 'build/classes/main'
into 'target/classes'
}
}

The script is intended to be in the background as a daemon while editing/developing; whenever a
change is made to any source code, gradle will automatically compile and enhance the code. In this
way it eliminates the need to start up Maven and run the enhancer goal.

To use, you must disable the Intelli]’s automatic building of the 'dom' project. This is done using:
File > Settings > Build, Execution, Deployment > Compiler > Excludes, and then exclude the -
/dom/src/main/java directory:
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11} Settings x

'.,‘ /' Build, Execution, Deployment > Compiler > Excludes
Appearance & Behavior Path Recursively | +
Keymap CAAPACHEYsis-git-re\example\archetype\simpleapp\src\main\resources\archetype-resources
Editor CAAPACHEYsis-git-re\example\application\simpleapp\dom\srd\main\java
Plugins

Version Control
Build, Execution, Deployment
Build Tools
Compiler
Java Compiler
Annotation Processors
Validation
RMI Compiler
Groovy Compiler
Kotlin Compiler
Coverage
Debugger
Required Plugins
Languages & Frameworks
Tools
Other Settings

m Cancel Help

The script can be run in the background using:

gradle -t --offline &

from the command line (in the dom module).

MINGWE'»?_:!G"APACHEfisis—git-rw.."example."applicationfsimpleé%}pfdom = O X

$ gradle -t ——offline
Continuous build is an incubating feature.
:compileJava
DataNucleus : JIDO Query - domainapp.dom.simple.SimpleObject -> domainapp.dom.sim
ple.qQsimpleobject
taNucleus JIDO AnnotationProcessor for generating T"peﬁafc cTass s
A CHE® is-git- examp le\application\simpleapp\dom\srci\main\java\doma
mpleObject.java uses or overrides a deprecated API.
ith -Xlint:deprecation for details.
5 i example\application\simpleapp\dom\bui lTasses\main
mainap i e0Object.java uses unchecked or unsafe operations.
e: Recompile w1th -XTint:unchecked for details.

Perfn|m1nq DataNucleus JIDO byte code transformation.

ENHANCED (Persistable) : domainapp.dom.simple.SimpleObject

DataNucleus Enhancer completed with success for 1 classes. Timings : input=164 m
s, enhance=536 ms, total=220 ms. Consult the log for full details

1 classes enhanced.

:copyClasses

SUCCESSFUL
Total time:

waiting for changes to input files of tasks...

Using Gradle for liveReload

Similarly, gradle can be run to reduce the turn-around time when tweaking the UI (defined by the
*,layout.xml file for each domain class), when the app is running.

The framework will automatically notice any changes to .1layout.xml files, but these are read from
the the classpath (the target/classes directory), not the source path. With IntelliJ these can be
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copied over manually by invoking Run > Reload Changed Classes. Once the browser is refreshed,
the new layout will be rendered.

0 We’ve occasionally noticed that this interferes with Wicket’s own javascript -
switching tabs becomes unresponsive. The work-around is just to reload the page.

To reduce the turn-around time there are therefore two steps to be automated:

* the copying of the .1layout.xml files over to the target/classes directory

* the triggering of a page refresh by the browser.

The layouts.gradle script takes care of the first of these; whenever a change is made to any
.layout.xml file, gradle will automatically copy over the file to the target/classes directory:

layouts.gradle

defaultTasks 'copylayouts'
task copylLayouts(type:Copy) {
from 'src/main/java’
into 'target/classes’
include '**/*.layout.xml'

Similarly, the liveReload.gradle script takes care of the browser refresh:

liveReload.gradle

defaultTasks 'liveReload'
buildscript {
repositories {
jeenter()
}
dependencies {
classpath 'org.kordamp.gradle:livereload-gradle-plugin:0.2.1"
}

¥
apply plugin: 'org.kordamp.gradle.livereload’

liveReload {
docRoot new File('target/classes').canonicalPath

}

These scripts can be run together using:

gradle -t --offline -b layouts.gradle &
gradle -t --offline -b liveReload.gradle &

from the command line (in the dom module):
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MINGW32:/c/ APACHE/isis- git-rw/example/application/simpleapp/dem = O X

J/APACHE /isis-git-rw/ application/simpleapt

-t ——offline -b layouts.gradle &

/

/C/APACHE /isis—-git-rw/example/application/simpleapp/dom (m

$ Continuous build is an incubating feature.
: copylLayouts UP-TO-DATE

BUILD SUCCESSFUL
Total time: 2.525 secs

waiting for changes to input files of tasks...

ACHE /isis-git-rw/example/application/simpleapt

' graﬁ]e -t —-offline -b liveReload.gradle &

2] 25552
JC/APACHE /isis—-git-rw/example/application/simpleapp/dom (m

Continuous build is an incubating feature.
:TiveReload
Enabling Li eload at port 35729 for C:\APACHE\isis-git-rw\example\application\
simpleapp’\d target\classes

/C/APACHE /isis-git-rw/example/application/simpleapp/

Running gradle -t —-offline -b layouts.gradle &
Running gradle -t --offline -b TiveReload.gradle &

/C/APACHE /isis-git-rw/example/application/simpleapp/

Live reload also requires that the isis.viewer.wicket.liveReloadUrl configuration property is set
appropriately:

viewer_wicket.properties

isis.viewer.wicket.liveReloadUrl=http://localhost:35729/1ivereload.js?snipver=1

You can confirm the script is loaded correctly using the web browser’s development tools, eg:
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&« C A | [1 localhost:8080/wicket/entity?3 e =

Simple App  Simple Objects ~ Prototyping ~ & isis-module-security-admin -

@A O0objects e

Name

4

Mo Records Found

Apachelsis™  About

(w ﬂ Elements Console Sources Network Timeline Profiles Resources Security Audits  EditThisCookie i X
Sources | Content scripts  Snippets : | [E |(index) x | » I n ve @ Async
v O top 1| ¥ watch + ¢
» localhost:8080 thing === null 1
» S (no domain) ¥ Call Stack
» S window Resizer Not Paused

> fonts.googleapis.com

¥ Scope

» O fonts.gstatic.com X

used
v localhost:35729
livereload js?snipver=1 - GOl
k lo Bre

» DOM Breakpoints
» XHR Breakpoints o=

» Event Listener Breakpoints
» Event Listeners

r

Setting up DCEVM

DCEVM enhances the JVM with true hot-swap adding/removing of methods as well as more reliable
hot swapping of the implementation of existing methods.

In the context of Apache Isis, this is very useful for contributed actions and mixins and also view
models; you should then be able to write these actions and have them be picked up without
restarting the application.

Changing persisting domain entities is more problematic, for two reasons: the JDO/DataNucleus
enhancer needs to run on domain entities, and also at runtime JDO/DataNucleus would need to
rebuild its own metamodel. You may find that adding actions will work, but adding new properties
or collections is much less likely to.

To set up DCEVM, download the appropriate JAR from the github page, and run the installer. For
example:

java -jar DCEVM-1light-8u51-installer.jar

Be sure to run with appropriate privileges to be able to write to the installation
directories of the JDK. If running on Windows, that means running as
Administrator.

After a few seconds this will display a dialog listing all installations of JDK that have been found:
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|£| Dynamic Code Evolution VM Installer

- O x
Dynamic Code Evolution VM
A modification of the Java HotSpot{TM) VM that allows unlimited class redefinition at runtime.
Nevw Varsion
Enhance current Java (JRE/JDE) installations with DCEVM (http://github.com/dcevm/dcevm) - ~
¥ou can either replace current Java VM or install DCEVM as alternative JWM (run with -¥Haltjvm—dcevm command-line option).
This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License
wersion Z only, as published by the Free Software Foundation.
This code is distributed in the hope that it will ke useful, but WITHOUT ANY WARRANTY; without even the implied warranty of W
Flease choose installation directory:
Directory Java Version Type Replaced by DCEVM? Installed altjvm?
C:\Program Files\Javaljdk1.7.0_79 1.7.0_79 oK (548it)  |No o
C:\Program Files\Javaljdk1.8.0_45 1.8.0_45 DK (54 Bit) Mo Mo
ogra avaijd a.0 8.0 DK (64 B ] ]
C:'\Program Files\Java\jre1.8.0_85 1.8.0_65 JRE (54 Bit) Mo Mo
C:\Program Files\Javaljre7 1.7.0_79 JRE (54 Bit) Mo Mo
C:\javaljprofilera Could not get ... [JDK Mo Mo
| Add installation directory... | Uninstall | Replace by DCEVM | | Instal DCEVM as aljvm 4
a2
Select the corresponding installation, and select Replace by DCEVM.
| £ Dynamic Code Evolution VM Installer - O *
Dynamic Code Evolution VM
A modification of the Java HotSpot{TM) VM that allows unlimited class redefinition at runtime.
Nerw Varsion
Enhance current Java (JRE/JDK) installations with DCEVM (http://github.com/dcevm/dcevm) - [l
¥You can either replace current Java VM or instzll DCEVM as alternative JVM (run with -EXaltjvr=dcevm command-line option).
This program is free scftware; you can redistribute it and/or modify it under the terms of the GNU General Public License
wersion Z only, as published by the Free Software Foundation.
This code is distributed in the hope that it will ke useful, but WITHOUT ANY WARRANTY; without even the implied warranty of W

Flease choose installation directory:

Directory Java Version  Type Replaced by DCEVM? Installed altjvm?
C:\Program Files\Javaljdk1.7.0_73 1.7.0_79 |30k (64 Bit) |No [
C:\Program Files\Javaljdk1.5.0_45 1.8.0_45 0K (54 Bit) Mo Mo
ogra avaljdk1.8.0 8.0 DK (64 B ho3-d g 0
C:'\Program Files\Java\jre1.8.0_85 1.8.0_65 JRE (54 Bit) Mo Mo
C:\Program Files\Java\jre7 1.7.0_79 JRE (54 Bit) Mo Mo
C:\javaljprofilera Could not get ... [JDK Mo Mo

| Add installation directory... | Replace by DCEVM Install DCEVM as altjvm

In Intelli], register the JDKin File > Project Structure dialog:
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I Project Structure
& + -
[21.8.0.65

Project Settings
[21.8.0_51 (DCEVM patched)

Project

Modules

Libraries

Facets

Artifacts
Platform Settings

SDKs.

Global Libraries

Problems @

Name: [1.8‘0_51 (DCEVM pa‘tchedb

JDK home path:

J Classpath | Sourcepath |Anr|otat|ons ‘ Documentation Paths

C:\Program Files\Java\jdk1.8.0_51\jre\lib\javaws jar

\Program Files\Javayjdk1.8.0_51\jre\lib\jcejar

AProgram Files\Javayjdk1.8.0_51\jre\lib\jfrjar

C\Program Files\Javayjdk1.8.0_51\jre\lib\jfxswt.jar

AProgram Files\Javayjdk1.8.0_51\jre\lib\jssejar

AProgram Files\Javayjdk1.8.0_51\jre\lib\management-agentjar
C\Program Files\Javayjdk1.8.0_51\jre\lib\pluginjar

A\Program Files\Javayjdk1.8.0_51\jre\lib\resources.jar
A\Program Files\Javayjdk1.8.0_51\jre\lib\rt.jar

AProgram Files\Javayjdk1.8.0_51\jre\lib\ext\access-bridge-64 jar
\Program Files\Javayjdk1.8.0_51\jre\lib\ext\cldrdatajar
\Program Files\Javaydk1.8.0_51\jre\lib\ext\dnsns jar
A\Program Files\Javayjdk1.8.0_51\jre\lib\ext\jaccessjar
C\Program Files\Javayjdk1.8.0_51\jre\lib\ext\jfxrt jar

\Program Files\Javayjdk1.8.0_51\jre\lib\ext\localedata.jar
A\Program Files\Javayjdk1.8.0_51\jre\lib\ext\nashorn,jar
C\Program Files\Javayjdk1.8.0_31\jre\lib\ext\sunecjar
\Program Files\Javayjdk1.8.0_51\jre\lib\ext\sunjce_provider.jar
A\Program Files\Javayjdk1.8.0_51\jre\lib\ext\sunmscapijar
C\Program Files\Java\jdk1.8.0_51\jre\lib\ext\sunpkcs11.jar
\Program Files\Javayjdk1.8.0_51\jre\lib\ext\zipfs jar

> B () (] [

A\Program Files\Javaydk1.8.0_51\jre\lib\charsets.jar +
\Program Files\Javayjdk1.8.0_51\jre\lib\deploy.jar —

Finally, in the run configuration, select the patched JDK:

J Run/Debug Configurations

+-H ¥+ 40Ol

[Z) Application
[ isisaddons
CJincode
[ other
B isisaddons-app-quickstart-webapp (with fixtures)
I?‘E\slsadduns—ap;:r—knchens|nk—'.'.fel:»a;:»;:r
Hincode-meodule-commchannel-webapp (with fixtures)
Hincode-module-note-webapp (with fixtures)
Hincode-module-note-webapp (no fixtures)
& simpleapp-webapp
B simpleapp-webapp (with fixtures)
BHlsisCh

[ Junit

2 Maven

% Defaults

X

Name: | incode-module-commchannel-webapp (with fixtures) O Share O Single instance only

Configuration | Code Cnveraga| Lngs‘ Startup/Connection )
Main class: |org‘apache‘ls\s‘WebSer\ler ‘ D
VM options: | HE‘
Program arguments: | -m org.incode.module.commchannel.app.CommChannelModuleAppManifestWithFixtures ‘@
Working directory: |SMODULE_DIRS H\HE|
Environment variables: | -]
Use classpath of mgd... ||_1 incode-module-commchannel-webapp n
Use alternative JRE: Iw‘a.u_sw [DCEVM patched)| HD

[ Enable capturing form snapshots

~ Before launch: Make, Maven Goal
+ - 2721 3 [s
Hi Make

M Run Maven Goal 'Incode CommChannel Module: -f pom-jdo-enhance-all.xml datanucleus:enhance -0

(] Show this page

El = (=) =]

Setting up JRebel

See the repo for the (non-ASF) Isis JRebel plugin. With some modification, this should work for

Intelli] too.

Note that JRebel is a commercial product, requiring a license. At the time of writing there is also
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currently a non-commercial free license (though note this comes with some usage conditions).

2.2. Developing using Eclipse

o This material does not constitute an endorsement; Eclipse foundation is not
affiliated to Apache Software Foundation in any way.

If you are an Eclipse user, then we recommend you download the "Eclipse JEE package"
configuration.

When running an Apache Isis application, it’s necessary to setup the development environment so
that the Java bytecode can be enhanced by the DataNucleus enhancer. If working in Eclipse, then
JDO enhancement is most easily done by installing the DataNucleus' Eclipse plugin. This hooks the
bytecode enhancement of your domain objects into Eclipse’s normal incremental compilation.

This plugin needs to be configured for each of your domain modules (usually just one in any given
app). The steps are therefore:

 import the project into Eclipse

* configure the DataNucleus enhancer

* run the app from the .1launch file
2.2.1. Screencast

This screencast shows how to import an Apache Isis maven-based application into Eclipse and
configure to use with the JDO Objectstore.

2.2.2. Editor Templates

We provide a set of editor templates. These are used to add new methods to existing classes. (These
are equivalent to the Intelli] live templates):

* is (Apache Isis domain objects). Download
* ju (for JUnit tests) Download

* jm (for JMock mocks or libraries) Download

To install, download each XML file, then go to Windows > Preferences > Java > Editor > Templates
and choose Import.

2.2.3. Importing the Project

Use File > Import, then Maven > Existing Maven Projects.

2.2.4. Add DataNucleus support

Q Make sure you are in the 'Java' Perspective, not the 'Java EE' Perspective.
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In Eclipse, for the domain object model project, first add DataNucleus support:

e
4 I'"EE = COMLEUr

b e sre/n
i+ [ sre/ma
b B sroftest
- = JRE Sys
[ = Maven
[ [= .setting
I = ide
b = lib
by = sre
[ = target
[= target-
I = uml
K| classp
| -gitigne
%) > proj
datanu
[} > pem

CoMm.eurcg

[

CoMm.eurad

iP5 8.

[

[+

[ Cnm e
L

Unit | %5 Debug
%

B <terminated>
@] <terminate
7] <terminated>
@ =terminate

® &

% LI

Copy Qualified Mame
Paste
Delete

Remove from Context
Build Path
Source

Refactor

Import...
Export...

Refresh

Close Project

Close Unrelated Projects
Assign Working Sets..,

Run Az

Debug As

Profile As

Mark as Deployable
Validate

Team

Compare With
Replace With

Restore from Local History...

DataMucleus

Maven

Then turn on Auto-Enhancement:

Ctrl+V
Delete

Ctrl+Alt+5hift+ Down
2
Alt+Shift+5 »
Alg+Shift+T »

F5

</dependency
k< /dependencies:
bendency.‘ianagement *

endenciess

kdependency:
<groupldrorg.apache.isis</gr
<artifactId»applib</artifact
k /dependency:

kdependency:
<groupldrorg.apache.isis.run
cartifactId>jdo-applib</arti
k /dependency:

kdependency:
<groupldrorg.apache.isis.run
cartifactId>jdo-datanucleus<

K //dependency

Kdependency
<groupIdrorg.xnap.commons<,/g

<artifartTdreettext -rommons<
T

encies | Dependency Hierarchy | Effective P

=, 0 others

ar constraints (DTD or XML schema) detect
ar constraints (DTD or XML schema) detect
ar constraints (DTD or XML schema) detect
Jjava.math.BigDecimal is never used

Jjavaxjdo.annotationsldentity Type is neve

Add DataMucleus Support [

I iaviav irdn annntatinne TdfRenaratarStratam:
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al ;E‘J > com.eu B2 Copy Qualified Name </dependency>
b > sre/| (% Paste ChrleV </dependencies>
= I:pendency.‘-'lanagement>
b sre/m # Delete Delete
-
b i sreite bendenciess
i = JRE Sy Remove from Context Ctrl+Alt+Shift+ Down <dependency>
b Mave Build Path » <groupld>org.apache.isis</groupld:
; - <artifactIdrapplib</artifactId>
P& :settm Source Alt+Shift+5 » | & /denendencys
[ ide Jdep <y
lib Refactor Alt+Shift+T » | <dependency>
b <groupld>org.apache.isis.runtimes.
b > sre fxg Import. <artifactIdrjdo-applib</artifactIc
I+ = target ) </dependency>
[ target i Export.. <dependency>
b Gy uml | o <groupld:org.apache.isis.runtimes.
¢ Refresh F5 <artifactId>jdo-datanucleus</artif
K] .classg Close Project </dependency>
En 'gltlgr ) .
W - pro Close Unrelated Projects <dependency>
datan Assign Working Sets... <groupldrorg.xnap.commons</grouplc
EEI > ol cartifactTdreettewt-commons< /artif
[+ rﬂ% com eF:Jro e ' i L
' dencies | Dependency Hierarchy | Effective POM | pc
B 1—& com.eurg| Debug As D
Y 'M—'Q. laalaa W0l w) Erofile AS *
m
=—————— &% Markas Deployable gs, 0 others
Unit ﬁ? Debug ]
Yalidate Enable Auto-Enhancernent
& Team » t
51 <terminated T 5 Run Enhancer Tool t
: t
m <termina Replace With N Run Schema Tool
e e e Create persistencexml for project
DataMucleus 4 Remowve DataMucleus Support
e o [E Ve OO OIS IO ETET ST ST ey TS TIEVE
Update the classpath

DataNucleus' enhancer uses the domain object model’s own classpath to reference DataNucleus
JARs. So, even though your domain objects are unlikely to depend on DataNucleus, these references
must still be present.

See the earlier section on DataNucleus enhancer for details of the contents of the pom.xml. Chances
are it is already set up from running the SimpleApp archetype.

Then, tell DataNucleus to use the project classpath:
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When the enhancer runs, it will print out to the console:

El Console &2 u%|lé'u@'—ﬁ|25'[=ﬁ'=ﬁ
<terminated> DataMucleus Enhancer [Java Application] C\Program Files'Javaljreb\bin'javaw.exe (28 Mov 20
DataNucleus Enhancer (version 3.1.1) : Enhancement of classes -

DataNucleus Enhancer completed with success for 38 classes. Timings : input=132

1| T | P

Workaround for path limits (the DN plugin to use the persistence.xml)

If running on Windows then the DataNucleus plugin is very likely to hit the Windows path limit.
To fix this, we configure the enhancer to read from the persistence.xml file.

As a prerequisite, first make sure that your domain object model has a persistence.xml file. Then
specify the persistence-unit in the project properties:
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Workaround: If the enhancer fails

On occasion it appears that Eclipse can attempt to run two instances of the DataNucleus enhancer.
This is probably due to multiple Eclipse builders being defined; we’ve noticed multiple entries in
the Eclipse’s Debug view:

Ju JUnit %5 Debug i1 % - | b ' I %| .ﬁ'ﬁfl @ - )
<terminated> <unknown:
@1 <terminated, exit value: 1> C:\Program Files\Java\jre6\bin\javaw.exe (28 Nov 2012 17:10:26)
7] <terminated>DataMucleus Enhancer [Java Application]
@ <terminated, exit value: 1> C:\Program Files\Java\jref\ bin\javaw.exe (28 Nov 2012 17:10:27)

At any rate, you’ll know you’ve encountered this error if you see the following in the console:
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<terminated> DataMucleus Enhancer [Java Application] C:\Program Files\Java\jreb\bin'javaw.exe (28 Mov 2012 17:10:27)

% &EE 2B8-r8-°0

at
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at

Datalucleus Enhancer (version 3.1.1)
Exception in thread "main" java.lang.ClassFormatError: Duplicate field namefsignature in class file com/eu
java.
java.
java.
java.
java.
java.
java.
java.
java.
java.
sun.misc.Launcher$AppClassloader.loadClass (Unknown Source)

java
java
java
org.
arg.
org.
arg
org.
arg.
org

: Enhancement of classes

lang.ClassLoader.defineClassl(Native Method)
lang.ClassLoader.defineClassCond(Unknown Source)
lang.ClassLoader.defineClass(Unknown Source)

net.URLClassLoader.defineClass(Unknown Source)
net.URLClassLoader.access$@@8(Unknown Source)
net.URLClassLoadersl. run{Unknown Source)

net.URLClassLoader.findClass(Unknown Source)
lang.ClassLoader. loadClass(Unknown Source)

.lang.ClassLoader. loadClass(Unknown Source)
.lang.Class.forNamed(Native Method)
.lang.Class.forName(Unknown Source)

datanucleus.ID0ClassLloaderResolver. classOriull (JDOClassloaderResolver. java:548)

security.SecureClassLoader.defineClass(Unknown Source)

security.AccessController.doPrivileged(Native Method)

-

datanucleus.IDOClassLoaderResolver. classForName (JDOClassLloaderResolver. java:288)

datanucleus.IDOClassLoaderResolver. classForName (JDOClassloaderResclver. java:41@)

.datanucleus.metadata.MetabataManager. loadPersistencelnit(MetaDataManager.java:954)
datanucleus.enhancer.DataNucleusEnhancer.getFileMetadataForInput(DataNucleusEnhancer.java:i
datanucleus.enhancer.DataNucleusEnhancer.enhance (DataNucleusEnhancer.java:525)

.datanucleus.enhancer.DataNucleusEnhancer.main(DataNucleusEnhancer.java:1258)

i

m

The best solution is to remove DataNucleus support and then to re-add it:

4 |""ZE"J > com.eu| B2 Copy Qualified MName
boaf e osred| [ Paste Ctrl+V
b & sre/m M Delete Delete
b B srofte
i+ = JRE Sy Remove from Context Ctrl+ Alt+Shift+ Down
b= Mave Build Path
& jsettlrl Source Alt+Shift+5 ¥
b & ide
b lib Refactor Alt+Shift+T ¥
b g : sr:t g2y Import..
[ arg
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= target| =2 Export...
b Eguml | & Refresh F5

& 'CI,E,SSF Close Project

o -Qitign )

) > .pro Close Unrelated Projects

datan Assign Working Sets...

EEI > por

M., |
[ lzF COMm.euro
[+ :’_—é Com.euro

.|

[N ' T VU )

I

IUnit | %% Debug

k.

7] =terminated
@ <termina

Run As
Debug As
Profile As

EE'] Mark as Deployable

Validate

Team

Compare With

Replace With

Restore from Local History...

DataMucleus

</dependency>
</dependencies>
pendencyManagement

endenciess

<dependency>
<groupldrorg.apache.isis</grouplds>
<artifactIdrapplib</artifactId>

</dependency:

<dependency>
<groupldrorg.apache.isis.runtimes.
<artifactId>jdo-applib</artifactId

</dependency:

<dependency>
<groupldrorg.apache.isis.runtimes.
<artifactId»jdo-datanucleus</artif

</dependency

<dependency>
<groupldrorg.xnap.commons</groupld

cartifartTdrepttext -commons< fartif
I

dencies | Dependency Hierarchy | Effective POM | po

gs, 0 others
v | Enable Auto-Enhancement P
t
Run Enhancer Tool tt
th

Run Schema Tool

Create persistencexml for project

(Rem:}ve DataMucleus Support )
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If you consistently hit problems, then the final recourse is to disable the automatic enhancement
and to remember to manually enhance your domain object model before each run.

Not ideal, we know. Please feel free to contribute a better solution :-)
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2.2.5. Running the App

The simpleapp archetype automatically provides a .1launch configurations in the webapp module. You
can therefore very simply run the application by right-clicking on one of these files, and choosing
"Run As..." or "Debug As...".

0 The screencast above shows this in action.

2.2.6. Other domain projects.

There is nothing to prevent you having multiple domain projects. You might want to do such that
each domain project corresponds to a DDD module, thus guaranteeing that there are no cyclic
dependencies between your modules.

If you do this, make sure that each project has its own persistence.xml file.

And, remember also to configure Eclipse’s DataNucleus plugin for these other domain projects.

2.2.7. Advanced

In this section are a couple of options that will reduce the length of the change
code/build/deploy/review feedback loop.

Setting up DCEVM

DCEVM enhances the JVM with true hot-swap adding/removing of methods as well as more reliable
hot swapping of the implementation of existing methods.

In the context of Apache Isis, this is very useful for contributed actions and mixins and also view
models; you should then be able to write these actions and have them be picked up without
restarting the application.

Changing persisting domain entities is more problematic, for two reasons: the JDO/DataNucleus
enhancer needs to run on domain entities, and also at runtime JDO/DataNucleus would need to
rebuild its own metamodel. You may find that adding actions will work, but adding new properties
or collections is much less likely to.

For details of setting up DCEVM, see the corresponding section in the Intelli] documentation.
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Chapter 3. Building Apache Isis

3.1. Git

The Apache Isis source code lives in a git repo.

3.1.1. Installation

The easiest place to get hold of command-line git is probably the github download page.

On Windows, this also installs the rather good mSysGit Unix shell. We recommend that you enable
git for both the mSysgit and the Windows command prompt:

® ceseur o e

Adjusting your PATH environment
How would you like to use Git from the command line?

) Use Git Bash only

This is the most conservative choice if you are concerned about the stability
of your system. Your PATH will not be modified.

This option is considered safe and no conflicts with other tocls are known.
Only Git will be added to your PATH. Use this option if you want to use Git
from a Cygwin Prompt (make sure to not have Cygwin's Git installed).

) Run Git and included Unix tools from the Windows Command Prompt

Both Git and its accompanying Unix tools will be added to your PATH.

Warning: This will override Windows tools like find.exe and
sort.exe. Select this option only if you understand the implications.

http: i fmswsait. googlecode. canny

[ < Back ][ Mext = ][ Cancel ]

Once git is installed, the two main command line tools to note are:

* git command line tool

* gitk for viewing the commit history

If using Windows, note that github also have a dedicated Windows client. With a little hacking
around, it can also be made to work with non-github repositories.

If using Mac, you might also want to check out Atlassian’s Sourcetree.

Cloning the Apache Isis repo
First, clone the Apache Isis repo.

If you are a committer, then clone from the Apache read/write repo:

git clone https://git-wip-us.apache.org/repos/asf/isis.qgit

If you are not a committer, please see the contributing page for details on which repo to clone
from.
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Configuring Git

Next up is to configure your user name and password; see also Apache’s git docs:

git config user.name "<i>My Name Here</i>"
git config user.email <i>myusername@apache.org</i>

Next, configure the core.autocrlf so that line endings are normalized to LF (Unix style) in the rep;
again see Apache’s git page:

e on Windows, use:

git config core.autocrlf true

¢ on Mac/Linuzx, use:

git config core.autocrlf input

The Windows setting means that files are converted back to CRLF on checkout; the Mac/Linux
setting means that the file is left as LF on checkout.

We also recommend setting core.safecrlf, which aims to ensure that any line ending conversion is
repeatable. Do this on all platforms:

git config core.safecrlf true

Note that these settings are supplemented in the repo by the .gitattributes file and that explicitly
specifies line handling treatment for most of the common file types that we have.

Next, we recommend you setup this a refspec so that you can distinguish remote tags from local
ones. To do that, locate the [remote "origin"] section in your .git/config and add the third entry
shown below:

[remote "origin"]

url = ... whatever ...
fetch = ... whatever ...
fetch = +refs/tags/*:refs/tags/origin/*

This will ensure that a git fetch or git pull places any remote tags under origin/xxx. For
example, the'isis-1.0.0"tag on the origin will appear under‘origin/isis-1.0.0.

If you don’t use git outside of Apache, you can add the --global flag so that the above settings apply
for all repos managed by git on your PC.
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3.1.2. Getting help

Three commands of git that in particular worth knowing:
e git help command
will open the man page in your web browser
* git qui
will open up a basic GUI client to staging changes and making commits.
* gitk --all

will open the commit history for all branches. In particular, you should be able to see the local
master, which branch you are working on (the HEAD), and also the last known position of the
master branch from the central repo, called origin/master.

You might also want to explore using a freely available equivalent such as Atlassian SourceTree.
For further reading, see:

* git config man page
* .gitattributes man page

* .gitattributes git-scm.com docs

3.2. Installing Java

Apache Isis is compatible with Java 7 and Java 8. For every-day use, the framework is usually
compiled against Java 8.

Releases however are cut using Java 7, leveraging the Maven toolchains plugin).

Therefore install either/both of Java 7 JDK and Java 8 JDK. Note that the JRE is not sufficient.

Q If you intend to contribute back patches to Apache Isis, note that while you can
develop using Java 8 within your IDE, be sure not to use any Java 8 APIs.
3.2.1. Configure Maven toolchains plugin

If you are a committer that will be performing releases of Apache Isis, then you must configure the
toolchains plugin so that releases can be built using Java 7.

This is done by placing the toolchains.xml file in ~/.m2 directory. Use the following file as a
template, adjusting paths for your platform:
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<?xml version="1.0" encoding="UTF8"?>
<toolchains>
<toolchain>
<type>jdk</type>
<provides>
<version>1.8</version>
<vendor>oracle</vendor>
</provides>
<configuration>
<jdkHome>/usr/11b64/jvm/jdk1.8.0_65</jdkHome>
<l--
<jdkHome>c:\Program Files\Java\jdk1.8.0_65</jdkHome>
-->
</confiquration>
</toolchain>
<toolchain>
<type>jdk</type>
<provides>
<version>1.7</version> @
<vendor>oracle</vendor>
</provides>
<configuration>
<jdkHome>/usr/1ib64/jvm/jdk1.7.0_79</jdkHome>
<I--
<jdkHome>c:\Program Files\Java\jdk1.7.0_79</jdkHome>
-->
</configuration>
</toolchain>
</toolchains>

@ The Apache Isis build is configured to search for the (1.7, oracle) JDK toolchain.

The Apache Isis parent pom.xml activates this plugin whenever the apache-release profile is enabled.

3.3. Installing Maven
Install Maven 3.0.x, downloadable here.

Set MAVEN_OPTS environment variable:

export MAVEN_OPTS="-Xms512m -Xmx1024m"

Previously we suggested -XX:MaxPermSize=256m, but this option has been removed

in Java 8. (As of 1.9.0, Apache Isis is built using Java 8 but with source and target
set to JDK 1.7).
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3.4. Building all of Apache Isis

To build the source code from the command line, simply go to the root directory and type:
mvn clean install

The first time you do this, you’ll find it takes a while since Maven needs to download all of the
Apache Isis prerequisites.

Thereafter you can speed up the build by adding the -o (offline flag). To save more time still, we
also recommend that you build in parallel. (Per this blog post), you could also experiment with a
number of JDK parameters that we’ve found also speed up Maven:

export MAVEN_OPTS="-Xms512m -Xmx1024m -XX:+TieredCompilation -XX:TieredStopAtLevel=1"
mvn clean install -o -T1C

For the most part, though, you may want to rely on an IDE such as Eclipse to build the codebase for
you. Both Eclipse and Idea (12.0+) support incremental background compilation.

When using Eclipse, a Maven profile is configured such that Eclipse compiles to target-ide
directory rather than the usual target directory. You can therefore switch between Eclipse and
Maven command line without one interfering with the other.

3.5. Checking for Vulnerabilities

Apache Isis configures the OWASP dependency check Maven plugin to determine whether the
framework uses libraries that are known to have security vulnerabilities.

To check, run:
mvn org.owasp:dependency-check-maven:aggregate -Dowasp

This will generate a single report under target/dependency-check-report.html.
0 The first time this runs can take 10~20 minutes to download the NVD data feeds.

To disable, either run in offline mode (add -o or --offline) or omit the owasp property.

3.6. Checking for use of internal JDK APIs

Apache Isis configures the jdeps maven plugin to check for any usage of internal JDK APIs. This is
in preparation for Java 9 module system (Jigsaw) which will prevent such usage of APIs.

To check, run:
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mvn clean install -Djdeps

This will fail the build on any module that currently uses an internal JDK API.

A At the time of writing the isis-core-schema module fails the build.
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Chapter 4. AsciiDoc Documentation

Apache Isis' documentation (meaning the website and the users' guide, the reference guide and this
contributors’ guide) is written using Asciidoc, specifically the Asciidoctor implementation.

The website and guides are created by running build tools (documented below) which create the
HTML version of the site and guides. You can therefore easily check the documentation before
raising a pull request (as a contributor) or publishing the site (if a committer).

Publishing is performed by copying the generated HTML to a different git repository (isis-site). This
is synced by ASF infrastructure over to isis.apache.org.

And to help write the Asciidoc text itself, we provide some templates.

4.1. Where to find the Docs

The (Asciidoc) source code can be found at adocs/documentation (relative to root). Online you’ll find
it cloned to github here.

4.2. Naming Conventions

For documents with inclusions, use '_' to separate out the logical hierarchy:

XXX-XXX/XXX-XXX.adoc
_XXX-XXX_ppp-ppp.adoc
_XXX-XXX_QqQqQq-qqq.adoc
_XXX-XXX_QqQqQq-qqq_mmm-mmm.adoc
_XXX-XXX_QqQqQq-qqq_nnn-nnn.adoc

Any referenced images should be in subdirectories of the images directory:

XXX-XXx/1mages/.

/ppp-ppp/ .

/q9q-qqq/ .
/mmm-mmm

/nnn-nnn
And similarly any resources should be in the resources subdirectory:

XXX-XXx/resources/.

PPP-ppp/ -

q99-qqq/.
/mmm-mmm/

/nnn-nnn/
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4.3. Writing the docs

We highly recommend that you install the (Intelli]) live templates for Asciidoctor, as described in
IDE templates. These provide a large number of helper templates.

An appendix lists all the templates available, demonstrating their intended usage and output.

4.4. Build and Review (using Maven)

To (re)build the documentation locally prior to release, change into the adocs/documentation
directory and use:

mvn clean compile

The site will be generated at target/site/index.html.

You could then use a web server such as Python’s SimpleHTTPServer to preview (so that all
Javascript works correctly). However, instead we recommend using instant preview, described
next.

4.5. Instant Rebuild (using Ruby)

The ruby script, monitor.rb emulates the mvn compile command, regenerating any changed
Asciidoctor files to the relevant target/site directory. Moreover if any included files are changed
then it rebuilds the parent (per the above naming convention).

4.5.1. One-time setup
To setup:

* download and install ruby 2.0.0, from http://rubyinstaller.org/downloads/

* download devkit for the Ruby 2.0 installation, also from http://rubyinstaller.org/downloads/.
Then follow the installation instructions on their wiki

0 We use Ruby 2.0 rather than 2.1 because the wdm gem (required to monitor the
filesystem if running on Windows) is not currently compatible with Ruby 2.1.

To download the required Ruby dependencies, use:

gem install bundler
bundle install

4.5.2. Instant Rebuild

To run, we typically just use:
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sh monitor.sh

This script simply runs mvn clean compile && ruby monitor.rb -b. The mvn command performs a
clean rebuild of the site, and then the ruby script monitors for any further changes under
src/main/asciidoc.

The script also starts up a web server on port 4000 so you can review results. If any .adoc changes,
then the appropriate HTML will be regenerated. And, if any new assets (CSS, images etc) are added,
they will be copied across. The -b flag passed through means that the script also starts a web
browser pointing at the newly generated docs.

The monitor.rb script has a couple of other options, use -h flag for usage:

ruby monitor.rb -h

which should print:

usage: monitor.rb [options]

-p, --port port (default: 4000)
-b, --browser launch browser
-h, --help help

4.6. Publish procedure

Only Apache Isis committers can publish to isis.apache.org. We’ve decided to include these
procedures here here (rather than put them in the Committers' Guide), just to keep things together.

4.6.1. One-time setup

The generated site is published by copying into the content/ directory of the isis-site git repo. You
therefore need to check this out this repo.

The procedure assumes that two git repos (for isis itself and for isis-site) are checked out into the
same parent directory, eg:

/APACHE/
isis/ # checkout of isis.git
adocs/
documentation/
README . adoc # this file you are reading right now
isis-site/ # checkout of isis-site.git
content/ # the published website

If this isn’t the case, then it is possible to override the relative directory by passing in a system
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property to the mvn goal; see below.

You also need to know that ASF’s publishing script work from the 'asf-site’ branch, NOT from the
'master’ branch. Therefore, in the isis.git repo site:

git checkout asf-site

4.6.2. Publishing (full build)

Back in the adocs/documentation directory of the main isis-git.repo, to copy the generated
documents to the isis-site.git repo, run:

mvn clean package

This deletes the entire content of contents, and replaces with the content under target/site. It also
fixes up line endings, standardizing on unix-style LFs.

If you have checked out the isis-site.git repo into some other directory (relative
Q to isis.site.git), then this can be overridden by specifying ‘-Disis-

site.dir="-- when calling mvn.

To copy and to also commit the generated documents to the isis-site.git repo, run:
sh publish.sh "ISIS-nnnn: a custom commit message"

Behind the scenes this just calls mvn clean install -Dmessage=:--.

It’s also possible to omit the message, in which case publish.sh will reuse the most recent commit
message from the main isis.git repo.

Pushing the commits (in the isis-site.git directory, of course) will publishing the changes:
git push

Double check at isis.apache.org.

4.6.3. Publishing (partial build)

If none of the guides have been changed, and if you have run the full rebuild recently, then you can
skip the generation of PDFs using:

mvn install -Dskip.pdf -D"ISIS-nnnn: a custom commit message"

The clean goal must not be included though (else all the guides will disappear from the site
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Chapter 5. Contributing

This page explains how you can contribute to Apache Isis. Yow’ll probably also want set up your IDE
and learn how to build Apache Isis.

Thanks for considering to help out, your contributions are appreciated!

5.1. Recommended Workflow (github)

Apache Isis' source code is hosted in an Apache git repo (https, http), with a clone on github (https,
or ssh: git@github.com:apache/isis.git.

As you might imagine, only committers are permitted to push changes to the central git repo. As a
contributor, we recommend that you fork the apache/isis repo in github, and then use your fork as
a way of publishing your patches for the Apache Isis committers to apply.

The diagram below illustrates the process:

git.apache.org/
isis.git

f git-wip-us.apache.org/
: repos/asf/isis.git

1. one-time fork
github.com/
apache/isis_git

github.com/

it pull . S
gitp joedeveloper/isis.git

: one-time git push
clone

7.Review & apply

pull request

- .~ 2.one-time

".

- 3. git pull
local git clone gt pu local git clone clone
5. Create JIRA
6. raise github
pull request
COMMITTER CONTRIBUTOR

That is:

1. as a one-time activity, you fork the github.com/apache/isis repo into your own fork on
github.com

2. as a one-time activity, you clone your fork to your local computer

3. you set the github.com/apache/isis as your upstream branch; this will allow you to keep your
local clone up-to-date with new commits

56


https://git-wip-us.apache.org/repos/asf/isis.git
http://git-wip-us.apache.org/repos/asf/isis.git
https://github.com/apache/isis.git
https://github.com/apache/isis.git
images/contributing/git-workflow.png
https://github.com/apache/isis.git
https://github.com/apache/isis.git

* note the asymmetry here: the upstream repo (the Apache github repo) is not the same as the

origin repo (your fork).

4. you work on your changes locally; when done, you push them to your github fork

5. to contribute back a change, raise a JIRA ticket, and ensure your commit message is in the form:
ISIS-nnnn: --- so that changes can be tracked (more discussion on this point below). In any case,
before you decide to start hacking with Apache Isis, it’s always worth creating a ticket in JIRA

and then have a discussion about it on the mailing lists.
6. Use github to raise a pull request for your feature

7. An Apache Isis committer will review your change, and apply it if suitable.

5.2. Alternative Workflow (JIRA patches)

As an alternative, you may decide to clone directly from github.com/apache/isis rather than create

your own fork:

git.apache.org/
isis.git

g git-wip-us.apache.org/
repos/asf/isis.git

github.com/
apache/isis.git

: git pull
- one-time git push
clone

git apply

e
-

git format-patch
local git clone

CONTRIBUTOR

local git clone

COMMITTER

one-time
clone

In this case your upstream repo is the same as your origin repo, which might seem more
straightforward. On the other hand, if you go this route then you’ll need create patches locally and

attach them to the JIRA ticket.

For the Apache Isis committers it really doesn’t matter which route you take, so go with whatever’s

most comfortable.
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5.3. Setting up your fork/clone

If you choose to create your own fork then youw’ll need an account on github.com. You then fork
simply by pressing the "Fork" button:

apache / isis G5 Watch -~  # Star o0 3

mirrored from git:/git.apache.orgfisis. git

Code Network Pull Requests 0 Graphs

An account isn’t needed if you just clone straight from the github.com/apache/isis.

Whether you’ve forked or not, you then need to clone the repo onto your computer. Github makes
this very easy to do:

» for Windows users, we suggest you use github’s 'Clone in Windows' feature

* for Mac/Linux users, create a clone from the command line:

Again, the info is easily found in the github page:

apache / isis G5 Watch ~ s Star

mirrered from git://git.apache. crgfisis. git

Code Network Pull Requests 0

Mirror of Apache Isis

( 2% Clone in Windows ] 2 ZIP [HTI’P SSH  GitRead-Only https://github.com/apache/isis.git ]
4

¥ branch: master - Files Commits Branches 4

If you've created your own fork, then you need to add the upstream remote to the
github.com/apache/isis. This remote is traditionally called upstream. You should then arrange for
your master branch to track the upstream/master remote branch:

If you didn’t create your own fork, you can omit the above step. Either way around, you can now
fetch new commits using simply:

git fetch

For more info on tracking branches here and here.

5.4. Commit messages

Although with git your commits are always performed on your local repo, those commit messages
become public when the patch is applied by an Apache Isis committer. You should take time to
write a meaningful commit message that helps explain what the patch refers to; if you don’t then
there’s a chance that your patch may be rejected and not applied. No-one likes hard work to go to
waste!
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We therefore recommend that your commit messages are as follows [1]:

ISIS-999: Make the example in CONTRIBUTING imperative and concrete

Without this patch applied the example commit message in the CONTRIBUTING
document is not a concrete example. This is a problem because the
contributor is left to imagine what the commit message should look like
based on a description rather than an example. This patch fixes the
problem by making the example concrete and imperative.

The first line is a real life imperative statement with a ticket number
from our issue tracker. The body describes the behavior without the patch,
why this is a problem, and how the patch fixes the problem when applied.

Once your git repo is setup, the next thing youwll most likely want to do is to setup your
development environment. See here for more details.

5.5. Creating the patch file

If you are working without a github fork of Apache Isis, then you can create the patches from your
own local git repository.

As per this stackoverflow question, create the patch using git format-patch:
git format-patch -10 HEAD --stdout > 0001-last-10-commits.patch

Here -10 is the last 10 commits you have done. You need to change that integer according to the
commits you need to apply into the patch.

5.6. Sample Contribution Workflow

Assuming you're development environment is all setup, let’s walk through how you might make
contribute a patch. In this example, suppose that you’ve decided to work on JIRA ticket #123, an
enhancement to support Blob/Clob datatypes.

5.6.1. Update your master branch

The first thing to do is to make sure your local clone is up-to-date. We do this by retrieving new
commits from upstream repo and then merging them as a fast-forward into your local branch.

Irrespective of whether you are using a github fork, the upstream for your local master branch will
be tracking the appropriate remote’s master branch. So n either case, the same commands work:

Alternatively, you can combine the git fetch and git merge and just use git pull: <pre> git
checkout master git pull —ff-only </pre>

If the merge or pull fails, it means that you must have made commits and there have been changes
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meanwhile on the remote master’s branch. You can use ‘gitk --all to confirm. If this fails, see our
git cookbook page for a procedure to retrospectively sort out this situation.

5.6.2. Create a topic branch

We recommend you name topic branches by the JIRA ticket, ie <tt>ISIS-nnn-description</tt>. So let’s
create a new branch based off master and call it "ISIS-123-blobs"

You can confirm the branch is there and is your new HEAD using either gitk --all. Alternatively, use
the command line:

$ git checkout -b ISIS-123-blobs

The command line prompt should also indicate you are on a branch, isolated from any changes that
might happen on the master branch.

5.6.3. Make File Changes and Commit
Next, make changes to your files using the usual commands (see also our git cookbook section):

« git add

o git mv

o git rm

o git commit

« git status

and so on.

Continue this way until happy with the change. Remember to run all your tests on the topic branch
(including a full mvn clean install).

5.6.4. Rebasing with master

Before you can share your change, you should rebase (in other words replay) your changes on top
of the master branch.

The first thing to do is to pull down any changes made in upstream remote’s master since you
started your topic branch:

These are the same commands that you would have run before you created your topic branch. If
you use gitk --all, there’s a good chance that new commits have come in.

Next, we reintegrate our topic branch by rebasing onto master: <pre> git checkout ISIS-123-blobs git
rebase master </pre>

This takes all of the commits in your branch, and applies them on top of the new master branch.
When your change is eventually integrated back in, it will result in a nice clear linear history on the
public repo.
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If the rebase fails because of a conflict, then you’ll be dumped into REBASE mode. Edit the file that
has the conflict, and make the appropriate edits. Once done:

Once the rebase has completed, re-run your tests to confirm that everything is still good.

5.6.5. Raising a pull request
If you have your own fork, you can now simply push the changes you’ve made locally to your fork:

This will create a corresponding branch in the remote github repo. If you use gitk --all, you’ll also
see a remotes/origin/ISIS-123-blobs branch.

Then, use github to raise a pull request. Pull requests sent to the Apache GitHub repositories will
forward a pull request e-mail to the dev mailing list. Yow’ll probably want to sign up to the dev
mailing list first before issuing your first pull request (though that isn’t mandatory).

The process to raise the pull request, broadly speaking:

* Open a web browser to your github fork of isis

* Select your topic branch (pushed in the previous step) so that the pull request references the
topic branch.

Click the Pull Request button.

Check that the Apache Isis mailing list email came through.

5.7. If your pull request is accepted

To double check that your pull request is accepted, update your master branch from the upstream
remote:

You can then use gitk --all (or git log if you prefer the command line) to check your contribution
has been added.

You can now delete your topic branch and remove the branch in your github:

Finally, you might want to push the latest changes in master back up to your github fork. If so, use:

5.7.1. If your pull request is rejected

If your pull request is rejected, then you’ll need to update your branch from the main repository
and then address the rejection reason.

You’ll probably also want to remove the remote branch on github:
git push origin —delete ISIS-123-blobs

... and continue as before until you are ready to resubmit your change.

[1] inspiration for the recommended commit format comes from the puppet project’s contributing
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page.
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Chapter 6. Appendix: Git Cookbook

This appendix describes the commands often used while working with git. In addition to these
basic commands, please make sure you have read:

* building Apache Isis
* Contributing

* Git policy

6.1. Modifying existing files

To modify existing files:

git add filename
git commit -m "ISIS-nnn: yada yada"

The git add command adds the changes to the file(s) to the git index (aka staging area). If you were
to make subsequent changes to the file these would not be committed.

The git commit takes all the staged changes and commits them locally. Note that these changes are
not shared public with Apache Isis' central git repo.

You can combine these two commands using -am flag to git commit:

git commit -am "ISIS-nnn: yada yada"

6.2. Adding new files

To add a new file:

git add .
git commit -m "ISIS-nnn: yada yada"

Note that this sequence of commands is identical to modifying an existing file. However, it isn’t
possible to combine the two steps using git commit -am; the git add is always needed when adding
new files to the repo.

6.3. Deleting files

To delete a file:
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git rm filename
git commit -m "ISIS-nnn: yada yada"

6.4. Renaming or moving files

To rename or move a file:

git mv <i>filename</i> <i>newfilename</i>
git commit -m "ISIS-nnn: yada yada"

6.5. Common Workflows

The contributing page describes the workflow for non-committers. The Git policy page describes a
workflow for Apache Isis committers.

6.6. Backing up a local branch

If committing to a local branch, the changes are still just that: local, and run risk of a disk failure or
other disaster.

To create a new, similarly named branch on the central repo, use:
git push -u origin <i>branchname</i>

Using gitk --all will show you this new branch, named origin/branchname.

Thereafter, you can push subsequent commits using simply:
git push

Doing this also allows others to collaborate on this branch, just as they would for master.

When, eventually, you have reintegrated this branch, you can delete the remote branch using:
git push origin --delete <i>branchname</i>

For more detail, see these blogs/posts here and here.

6.7. Quick change: stashing changes

If you are working on something but are not ready to commit, then use:
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git stash

If you use gitk --all then you’ll see new commits are made that hold the current state of your
working directory and staging area.

You can then, for example, pull down the latest changes using git pull --rebase (see above).

To reapply your stash, then use:
git stash pop
Note that stashing works even if switching branches

6.8. Ignoring files

Put file patterns into .gitignore. There is one at the root of the git repo, but they can additionally
appear in subdirectories (the results are cumulative).

See also:

» github’s help page

* man page

6.9. More advanced use cases

6.9.1. If accidentally push to remote

Suppose you committed to master, and then pushed the change, and then decided that you didn’t
intend to do that:

¢t - €2 - G - ¢4 - ¢ - C - €7

N

master
N

origin/master
To go back to an earlier commit, first we wind back the local master:
git reset --hard (5

where (5 is the long sha-id for that commit.

This gets us to:
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Ll = 2 = 8 = W = 1ty = th = o

N

master
N

origin/master
Then, do a force push:
git push origin master --force

If this doesn’t work, it may be that the remote repo has disabled this feature. There are other hacks
to get around this, see for example here.

6.10. If you’ve accidentally worked on master branch

If at any time the git pull from your upstream fails, it most likely means that you must have made
commits on the master branch. You can use gitk --all to confirm; at some point in time both master
and origin\master will have a common ancestor.

You can retrospectively create a topic branch for the work you’ve accidentally done on master.

First, create a branch for your current commit:
git branch <i>newbranch</i>

Next, make sure you have no outstanding edits. If you do, you should commit them or stash them:
git stash

Finally, locate the shald of the commit you want to roll back to (easily obtained in gitk -all), and
wind master branch back to that commit:

git checkout master
git reset --hard <i>shald</i> # move master branch shald of common ancestor

6.11. If you’ve forgotten to prefix your commits (but
not pushed)

One of our committers, Alexander Krasnukhin, has put together some git scripts to help his
workflow. Using one of these, git prefix, you can just commit with proper message without
bothering about prefix and add prefix only in the end before the final push.

For example, to prefix all not yet prefixed commits master..isis/666 with ISIS-666 prefix, use:
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git prefix ISIS-666 master..isis/666

You can grab this utility, and others, from this repo.
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Chapter 7. Appendix: Working with Many
Repos

Applications built with Apache Isis often (should) consist of multiple modules, each in separate git
repositories. For example, there are the various (non-ASF) Isis Addons that provide various cross-
cutting concerns/technical services (security, mail-merge etc), as well the modules eg as provided by
the (non-ASF) Incode Catalog, which provides generic business subdomains (communication
channels, documents etc).

In addition, your own application may well be structured as a number of distinct modules
(probably with the entities in each module being mapped to a different schema), and using such
techniques as the event bus and mixins so that these modules are decoupled from each other.

All of which is a preamble to say that you will likely have multiple directories on your local
development computer, for each such git repository that you contribute to.

In this appendix we provide some simple but useful bash scripts to help you manage each such.

7.1. Prerequisites

We recommend that you adopt a convention for your directories. For example, open source
repositories (such as the Isis Addons and Incode Catalog mentioned above) reside in github.com,
while your own proprietary code might reside in some other service, eg bitbucket. For example:

/users/home/me/
BITBUCKET/
mycompany/
myapp-moduleA
myapp-moduleB
myapp
GITHUB/
isisaddons/
isis-module-docx
isis-module-security
incodehq/
incode-module-commchannel
incode-module-classification

7.2. _repos.txt

Create a file _repos.txt that catalogues the repositories, eg:
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ugbtb.pdf#_ugbtb_decoupling_event-bus
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#

# our code

#

/users/home/me/BITBUCKET/mycompany/myapp-moduleA
/users/home/me/BITBUCKET/mycompany/myapp-moduleB
/users/home/me/BITBUCKET/mycompany/myapp

#

# open source modules

#

/users/home/me/GITHUB/isisaddons/isis-module-docx
/users/home/me/GITHUB/isisaddons/isis-module-security
/users/home/me/GITHUB/incodehq/incode-module-commchannel
/users/home/me/GITHUB/incodehq/incode-module-classification

7.3. Bash functions
The .bash_functions file (downloadable from this gist) provides the following two functions:
* repo
Switches (using pushd) to the specified directory (as listed in the _repos.txt file).
» foreach

Runs the specified command for all (or matching) repositories (as listed in _repos. txt file).

For example,
repo doc

would switch to /users/home/me/GITHUB/isisaddons/isis-module-docx, the first module that matches
the fragment.

Meanwhile:
foreach git status

would perform a git status on every git repository, while
foreach -g isisaddons git fetch

would perform a git fetch but only to those repositories which match "isisaddons" (-g flag standing
for grep).

To load the functions into your profile (.bashrc or .profile or similar), use:
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Chapter 8. Appendix: Asciidoc Templates

This appendix lists the (Intelli]) live templates available for writing documentation using Asciidoc.

Instructions for installing the templates can be found here.

In the examples below the text xxx, yyy, zzz are correspond to template variables (ie placeholders).

8.1. Callouts

The Asciidoctor terminology is an "admonition".

Abbrev. Produces
adadmimporta [IMPORTANT]
n‘t —===

XXX

adadmnote [NOTE]

XXX

adadmtip [TIP]

XXX

adadmwarning [WARNING]

XXX

8.2. TODO notes

Example

[IMPORTANT] ==== XXX

[NOTE] ==== Xxxx ====

[TIP] ==== XXX ====

[WARNING] ==== XXX ====

Add as a placeholder for documentation still to be written or which is work-in-progress.

Abbrev. Produces
adtodo <pre>NOTE: TODO</pre>
adwip <pre>NOTE: WIP - xxx</pre> where: *

<code>xxx</code> is additional explanatory text

8.3. Xref to Guides

Cross-references (links) to the various guides

Example
NOTE: TODO

NOTE: WIP - cool new
feature
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Abbrev.

adcgcom

<pre>xref:dg
.adoc#xxx|[ttt
I</pre> a
hyperlink to
a bookmark
within the
developers'
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xref:dg
.adoc#_dg_as
ciidoc-
templates[As
ciidoc
templates]</
pre>
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Produces

<pre>xref:cgcom.adoc#xxx[ttt]</pre> a hyperlink to a
bookmark within the committers' guide, where: *
<code>xxx</code> is the bookmark&#8217;s anchor *
<code>ttt</code> is the text to display as the hyperlink
for example: <pre>xref:dg.adoc#_cgcom_cutting-a-
release[Cutting a release]</pre>

Asciidoc templates

Example

addg

adrgant



Abbrev. Produces

<pre>xrefirg Core annotations
ant.adoc#xx
x[ttt]</pre> a
hyperlink to
a bookmark
within the
reference
guide for
annotations,
where: *
<code>xxx</
code> is the
bookmark *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefirg
ant.adoc#_rg
ant-
aaa_main[Co
re
annotations]
</pre>

Example

adrgcfg
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rgant.pdf#_rgant-aaa_main

Abbrev. Produces

<pre>xrefirg Configuring Core
cfg.adoc#xxx
[ttt]</pre> a
hyperlink to
a bookmark
within the
reference
guide for
configuratio
n properties
guide,
where: *
<code>xxx</
code> is the
bookmark *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefirg
cfg.adoc#_rg
cfg_configuri
ng-
core[Configu
ring
Core]</pre>
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adrgems


rgcfg.pdf#_rgcfg_configuring-core

Abbrev. Produces

<pre>xrefirg AbstractService

cms.adoc#xx
x[ttt]</pre> a
hyperlink to
a bookmark
within the
reference
guide for
classes,
methods and
schema,
where: *
<code>xxx</
code> is the
bookmark *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefirg
cms.adoc#_r
gcms_classes
_super_Abstr
actService["
AbstractServ
ice ]</pre>

Example

adrgsvc

75


rgcms.pdf#_rgcms_classes_super_AbstractService

Abbrev. Produces

<pre>xrefirg AppManifest bootstrapping
svc.adoc#xXXX
[ttt]</pre> a
hyperlink to
a bookmark
within the
reference
guide for
domain
services,
where: *
<code>xxx</
code> is the
bookmark *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefirg
svc.adoc#_rg
cms_classes_
AppManifest
-bootstrappi
ng[ AppMan
ifest”
bootstrappin
gl</pre>
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adrgmvn


xref:rgsvc.pdf#_rgcms_classes_AppManifest-bootstrapping
xref:rgsvc.pdf#_rgcms_classes_AppManifest-bootstrapping

Abbrev.

<pre>xrefirg
mvn.adoc#x
xx[ttt]</pre>
a hyperlink
toa
bookmark
within the
reference
guide for the
maven
plugin,
where: *
<code>xxx</
code> is the
bookmark *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefirg
mvn.adoc#_r
gmvn_valida
te[validate
goal]</pre>

Produces

validate goal

Example

adrgna
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rgmvn.pdf#_rgmvn_validate

Abbrev. Produces

<pre>xrefirg @Action
ant.adoc#_rg
ant-

XxX[  @xXX"
&lt;/pre&gt;]
a hyperlink
to the "man
page" for an
annotation
within the
reference
guide for
annotations,
where: *
<code>xxx</
code> is the
annotation
type (eg
<code>@Acti
on</code>)
for example:
<pre>xrefirg
ant.adoc#_rg
ant-

Action[  @Ac
tion " ]</pre>

78

Example
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rgant.pdf#_rgant-Action

Abbrev.

<pre>xrefirg
ant.adoc#_rg
ant-

XXX_ttt[ " @xx
x#ttt() " &lt;/p
re&gt;] a
hyperlink to
the "man
page" for the
specific
attribute
(field) of an
annotation
within the
reference
guide for
annotations,
where: *
<code>xxx</
code> is the
annotation
type (eg
<code>@Acti
on</code>) *
<code>ttt</co
de> is the
attribute (eg
<code>@sem
antics</code
>) for
example:
<pre>xrefirg
ant.adoc#_rg
ant-
Action_sema
ntics[ @Acti
on#semantic
s() "I</pre>

Produces

@Actionf#isemantics()

Example

adrgsa
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rgant.pdf#_rgant-Action_semantics

Abbrev. Produces

<pre></pre> DomainObjectContainer
a hyperlink
to the "man
page" for an
(API) domain
service
within the
reference
guide for
domain
services,
where: *
<code>xxx</
code> is the
domain
service (eg
<code>Doma
inObjectCont
ainer</code>
) for
example:
<pre>xrefirg
svc.adoc#_rg
svc_api_Dom
ainObjectCo
ntainer[ Do
mainObjectC
ontainer " ]</
pre>
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adrgss


rgsvc.pdf#_rgsvc_api_DomainObjectContainer

Abbrev. Produces

<pre></pre> ContentMappingService
a hyperlink
to the "man
page" for an
(SPI) domain
service
within the
reference
guide for
domain
services,
where: *
<code>xxx</
code> is the
domain
service (eg
<code>Conte
ntMappingSe
rvice</code>
) for
example:
<pre>xrefirg
svc.adoc#_rg
svc_spi_Cont
entMapping$S
ervice[ Cont
entMapping$S
ervice ' ]</pr
e>

Example

adugfun
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rgsvc.pdf#_rgsvc_spi_ContentMappingService

Abbrev.

<pre>xrefiug
fun.adoc#xx
x[ttt]</pre> a
hyperlink to
a bookmark
within the
fundamental
s users'
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink
for example:
<pre>xrefiug
fun.adoc#_u
gfun_core-
concepts[Cor
e
concepts]</p
re>
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Produces

Core concepts

Example

adugvw


ugfun.pdf#_ugfun_core-concepts

Abbrev. Produces

<pre>xrefiug Customisation
vw.adoc#xxx
[ttt]</pre> A
hyperlink to
a bookmark
within the
Wicket
viewer
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink.
for example:
<pre>xrefiug
vw.adoc#_ug
VW_customis
ation[Custo
misation]</p
re>

Example

adugvro
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ugvw.pdf#_ugvw_customisation

Abbrev. Produces

<pre>xrefiug RestfulObjects specification
vro.adoc#xx
x[ttt]</pre>
A hyperlink
toa
bookmark
within the
Restful
Objects
viewer
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink.
for example:
<pre>xrefiug
vro.adoc#_ug
VIo_ro-
spec[Restful
Objects
specification
I</pre>
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adugsec


ugvro.pdf#_ugvro_ro-spec

Abbrev. Produces

<pre>xrefiug Caching and other Shiro Features
sec.adoc#xxx
[ttt]</pre> A
hyperlink to
a bookmark
within the
Secrurity
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink.
for example:
<pre>xrefiug
sec.adoc#_ug
sec_shiro-
caching[Cac
hing and
other Shiro
Features]</p
re>

Example

adugtst
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ugsec.pdf#_ugsec_shiro-caching

Abbrev. Produces

<pre>xrefiug BDD Spec Support
tst.adoc#xxx|
ttt]</pre> A
hyperlink to
a bookmark
within the
Testing
guide,
where: *
<code>xxx</
code> is the
bookmark&#
8217;s
anchor *
<code>ttt</co
de> is the
text to
display as
the
hyperlink.
for example:
<pre>xrefiug
tst.adoc#_ugt
st_bdd-spec-
support[BDD
Spec
Support]</pr
e>

8.4. Link to Isis Addons

Links to (non-ASF) Isis Addons

Abbrev. Produces

adlinkaddons <pre>(non-ASF) link:http://isisaddons.org[Isis
Addons]</pre> link to the Isis Addons website.

adlinkaddons <pre>(non-ASF) http://github.com/isisaddons/isis-app-

Example

adugbtb

Example

(non-ASF) Isis Addons

(non-ASF) Isis addons'

app xxx[Isis addons' xxx&lt;/pre&gt;] link to the github repo todoapp

for an example app from the Isis addons; where: *
<code>xxx</code> is the name of the example app
being linked to for example: <pre>(non-ASF)
http://github.com/isisaddons/isis-app-todoapplIsis
addons' todoapp]</pre>
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Abbrev. Produces Example

adlinkaddons <pre></pre> link to the github repo for a module from  (non-ASF) Isis addons’
module the Isis addons; where: * <code>xxx</code> is the name security module

of the module being linked to for example: <pre>(non-

ASF) http://github.com/isisaddons/isis-module-

security[Isis addons' security] module</pre>

adlinkaddons <pre></pre> link to the github repo for a wicket UI (non-ASF) Isis addons'
wicket component from the Isis addons; where: * gmap3 wicket extension
<code>xxx</code> is the name of the wicket Ul
component being linked to for example: <pre>(non-
ASF) http://github.com/isisaddons/isis-wicket-gmap3[Isis
addons' gmap3 ] wicket extension</pre>

8.5. Source code

Abbrev. Produces Example
adsrcjava [source,java] [source,java] -— public
)‘()‘()’(' classFoo{ ..}-—

---- where: * xxx is the source code snippet.

adsrcjavac  as for adsrcjava, but with a caption above

adsrcjavascr [source,javascript] [source,javascript] ——
"t >_<>_<x _ $(document).ready(functio
nO{..H;—

---- where: * xxx is the source code snippet.

E_ldircj avascr as for adsrcjavascript, but with a caption above
ipte

adsrcother [source,nnn]

XXX
---- where: * nnn is the programming language * xxx is
the source code snippet.

adsrcotherc  as for adsrcother, but with a caption above

adsrexml [source,javascript] [source,xml] ---- <html>
. <title> hello world!

XXX .
. . . </title> </html> ----
---- where: * xxx is the source code snippet.

adsrcxmle as for adsrcxml, but with a caption above

8.6. Images
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Abbrev. Produces Example

adimgfile <pre>image::{_imagesdir}xxx/yyy.png[width="WWWpx image::images/wicket-
"link="{_imagesdir}xxx/yyy.png"]</pre> embeds viewer/layouts/estatio-
specified image, where: * <code>xxx</code> is the Lease.png[width="300px",li
subdirectory under the <code>images/</code> directory nk="images/wicket-
* <code>yyy</code> is the image * <code>WWW</code> viewer/layouts/estatio-
is the width, in pixels. for example: Lease.png"]
<pre>image::{_imagesdir}wicket-viewer/layouts/estatio-
Lease.png[width="300px",link="{_imagesdir}wicket-
viewer/layouts/estatio-Lease.png"]</pre>

adimgfilec  asfor adimgfile, but with a caption above

adimgurl <pre>image::xxx[width="WWWpx" link="xxx"]</pre>
embeds image from specified URL, where: *
<code>xxx</code> is the URL to the image *
<code>WWW</code> is the width, in pixels.

adimgurlc as for adimgur1, but with a caption above

8.7. YouTube (screencasts)

Embedded youtube screencasts. (Don’t use these in guides, as they cannot be rendered as PDF).

Abbrev. Produces Example

adyoutube <pre>video::xxx[youtube,width="WWWpx",height="HH video::bj8735nBRR4[youtu
Hpx"]</pre> where: * <code>xxx</code> is the youtube be,width="210px",height="
reference * <code>WWW</code> is the width, in pixels 118px"]
* <code>HHH</code> is the height, in pixels for
example:
<pre>video::bj8735nBRR4[youtube,width="210px",heig
ht="118px"] </pre>

adyoutubec  as for youtube, but with a caption above

8.8. Tables

Abbrev. Produces Example

adtbl3 Table with 3 columns, 3 rows.

8.9. Misc.

Abbrev. Produces Example
adai <pre>Apache Isis</pre><br> That is, the literal text Apache Isis
"Apache Isis".
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Abbrev.
adlink

adanchany

adxrefany

adfootnote

Produces

Example

<pre>link:xxx[ttt]</pre>, where: * <code>xxx</code>is Apache Isis website

* <code>ttt</code> is the text to display as the hyperlink
for example: <pre>link:http://isis.apache.org[Apache
Isis website]</pre>

<pre>= anchor:[xxx]</pre> defines an inline anchor to
any heading, where: * <code>xxx</code> is the anchor
text. For example: <pre>= anchor:[_ugfun_i18n]
Internationalization</pre> An alternative (more
commonly used in our documentation) is to use the
<code>[[&#8230;&#8203;]]1</code> directly above the
heading: <pre>[[_ugfun_i18n]] =
Internationalization</pre>

<pre>xref:[xxx]</pre> cross-reference to any
document/anchor, where: * <code>xxx</code> is the
fully qualified document with optional anchor

<pre>.footnote:[]</pre> defines a footnote

. [1: this is a footnote]
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Chapter 9. Appendix: Project Lombok

Project Lombok is an open source project to reduce the amount of boilerplate in your code.

For example, rather than write:

private String name;
public String getName() {
return name;

}
public void setName(String name) {
this.name = name;

}

you can instead write simply:

@Getter @Setter
private String name;

Under the covers it is implemented as an annotation processor; it basically hooks into the Java
compiler so that it can emit additional bytecode (eg for the getter and setter). See here for details of
setting up in IntelliJ (Eclipse has very similar support).

Apache Isis supports Project Lombok, in that the annotations that would normally be placed on the
getter (namely Property, @Propertylayout, @Collection, @CollectionlLayout and @MemberOrder) can be
placed on the field instead.

There are plugins for Lombok for maven; it’s just a matter of adding the required dependency. To
compile the code within your IDE (eg so that its compiler "knows" that there is, actually, a getter
and setter) will require an Lombok plugin appropriate to that IDE. See the Lombok download page
for more information.

9.1. Future thoughts

In the future we might extend/fork Lombok so that it understands Isis' own annotations (ie
@Property and @Collection) rather than Lombok’s own @Getter and " @Setter.

It might also be possible to use Lombok to generate the domain event classes for each member.
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Chapter 10. Appendix: Agile]

This material does not constitute an endorsement; Agile] Structure Views is not
affiliated to Apache Software Foundation in any way. Agile] has however
provided a complimentary copy of its software to Apache Isis committers.

Agile] Structure Views is a commercial product to reverse engineer and visualize Java classes from
source code.

The key to using the tool is in developing a suitable filter script, a DSL. You can use the following
script as a starting point for visualizing Apache Isis domain models:

// use CTRL+SPACE for completion suggestions
hide all fields

hide setter methods

hide private methods

hide methods named compareTo

hide methods named toString

hide methods named inject*

hide methods named disable*

hide methods named default*

hide methods named hide*

hide methods named autoComplete*
hide methods named choices*

hide methods named title

hide methods named iconName

hide methods named validate*

hide methods named modify*

hide protected methods

hide types annotated as DomainService
hide types named Constants

hide types named InvoicingInterval
hide enums

hide constructors

hide
hide
hide
show
show
show
hide
hide
hide

For more information on Agile], see Paul Wells' 8-part tutorial series on Youtube; the first can be
found here (view the "show more" comments to click through to other parts).

inner types named
inner types named
inner types named
getter methods in
methods annotated
methods annotated
dependency lines
call lines

method lines

*Event
*Functions
*Predicates
green

as Programmatic in orange
as Action in largest
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